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Preface

This guide contains the information about configuring Kofax AP Agility. This guide is intended for solution
integrators who need a description of the installation and configuration procedures.

This guide is written with the assumption that you have a thorough understanding of these Kofax products:
• Kofax TotalAgility
• Kofax Invoice Processing Agility

Related documentation
The product documentation set for Kofax AP Agility is available at the following location.

https://docshield.kofax.com/Portal/Products/en_US/APAgility/2.1.0-drbywob7qp/APAgility.htm

In addition to this guide, see the documentation for the following products for additional installation and
configuration information.

Kofax AP Agility Installation Guide
The Kofax AP Agility Installation Guide provides instructions for installing Kofax AP Agility and integrating
it with Kofax TotalAgility.

Kofax Invoice Processing Agility Installation Guide
The Kofax Invoice Processing Agility Installation Guide provides instructions for installing Kofax Invoice
Processing Agility and integrating it with Kofax TotalAgility.

Kofax TotalAgility Installation Guide
This guide describes how to install and configure Kofax TotalAgility.

Release Notes
Late-breaking product information is available from the release notes. The release notes contain
information that may not be included in the Kofax AP Agility Administrator's Guide. Release notes are also
available for each of your installed Kofax applications. Locate release notes on the Kofax Support site at
www.kofax.com/support.

Product documentation
By default, the Kofax AP Agility documentation is available online. However, if necessary, you can also
download the documentation to use offline.
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Default online documentation
The product documentation for Kofax AP Agility 2.1.0 is available at the following location.

https://docshield.kofax.com/Portal/Products/en_US/APAgility/2.1.0-drbywob7qp/APAgility.htm

To launch the online help for the Kofax AP Agility app in the Kofax TotalAgility Workspace, click Help.

Configure offline documentation
To access the documentation offline, download KofaxAPAgilityDocumentation-2.1.0_EN.zip from the
Kofax Fulfillment Site and extract it on a local drive available to your users.

The compressed file includes both help and print folders. The print folder contains all guides, such as
the Installation Guide and the Administrator's Guide.

You can configure Kofax AP Agility to use offline help by following these steps.
1. Extract the contents of the compressed documentation file,

KofaxAPAgilityDocumentation-2.1.0_EN.zip.
2. Copy the contents of the extracted help folder to the following folder where Kofax TotalAgility is

installed:
Agility.Server.Web\Help\APAgility\en_US\2.1.0\

Note the following:
• This location is suggested because it is available and already used for Kofax TotalAgility offline

documentation. However, for Kofax AP Agility, it is possible to use any path for the help, as long as
it is on a web server available through http. Modify the paths below accordingly.

• Kofax AP Agility help is available in English only.
3. To configure the user help, log on as a user with administrator rights to Kofax AP Agility Designer.
4. Open Form Designer. In the Explorer panel, select Navigations.
5. Select AP Agility as the category and select AP Agility Menu.
6. Under Menu Items, select Help.
7. In the Target field, set the following URL:

http://<Server>/totalagility/Help/APAgility/en_US/2.1.0/index.html.
Where <Server> is host name or IP address of the Kofax TotalAgility server.

8. Save the settings and exit Kofax AP Agility Designer.
9. Open the AP Agility site.

10. Click Help.
The help should open, and the browser's address field indicates the URL where the help is
installed, such as http://<Server>/totalagility/Help/APAgility/en_US/2.1.0/
APAgility_help/c_welcome.html.
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Training
Kofax offers both classroom and computer-based training that will help you make the most of your Kofax
TotalAgility solution. Visit the Kofax website at www.kofax.com for complete details about the available
training options and schedules.

Getting help for Kofax products
Kofax regularly updates the Kofax Support site with the latest information about Kofax products.

To access some resources, you must have a valid Support Agreement with an authorized Kofax Reseller/
Partner or with Kofax directly.

Use the tools that Kofax provides for researching and identifying issues. For example, use the Kofax
Support site to search for answers about messages, keywords, and product issues. To access the Kofax
Support page, go to www.kofax.com/support.

The Kofax Support page provides:
• Product information and release news

Click a product family, select a product, and select a version number.
• Downloadable product documentation

Click a product family, select a product, and click Documentation.
• Access to product knowledge bases

Click Knowledge Base.
• Access to the Kofax Customer Portal (for eligible customers)

Click Account Management and log in.
To optimize your use of the portal, go to the Kofax Customer Portal login page and click the link to
open the Guide to the Kofax Support Portal. This guide describes how to access the support site, what
to do before contacting the support team, how to open a new case or view an open case, and what
information to collect before opening a case.

• Access to support tools
Click Tools and select the tool to use.

• Information about the support commitment for Kofax products
Click Support Details and select Kofax Support Commitment.

Use these tools to find answers to questions that you have, to learn about new functionality, and to
research possible solutions to current issues.
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Chapter 1

Overview

Kofax AP Agility is built on Kofax TotalAgility and allows you to automate accounts payable processes for
efficient and accurate invoice processing. The Kofax AP Agility solution uses Kofax Invoice Processing
Agility as a source of documents and its metadata. Use this solution to assess the effectiveness of your
accounts payable processes and measure staff productivity levels.

This application extends the capabilities of Kofax TotalAgility, Kofax Invoice Processing Agility, and your
Enterprise Resource Planning (ERP) system to optimize accounts payable processes and deliver data
when you need it.

Use Kofax AP Agility to:
• Streamline AP workflows
• Integrate with your ERP system
• Strengthen internal controls
• Improve process and status visibility
• Optimize cash management
• Reduce entry and processing errors
• Increase operational flexibility
• Assess supplier activity, invoice volumes and expenditures
• Identify duplicate invoices and approval violations

GL Account Coding
• Enter GL Account Code manually or select segment values from a list originating from the ERP system.
• Use the recently used values option to search for GL Account Code.

Approval
• Ensure that the correct resources approve invoices at the necessary points in the invoice process.
• Ensure that additional approvals and reviews are enforced based on invoice value and business unit

configuration.

Exception
• Process items that were routed to an exception workflow from any other workflow.
• Investigate and resolve all exceptions, such as potential duplicates, invalid reason code, invoice due

date calculation error.
• Cancel invoice processing.

Comment Request
• Request comments to acquire additional information within the workflow.
• Respond to the requested comment.
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Invoice Hold
• Put invoices on hold to suspend their further processing.
• Release the hold to resume invoice processing.

Document workflow
Kofax AP Agility takes data from Kofax Invoice Processing Agility and provides the possibility to assign
invoice lines to GL Account, approve invoices, and resolve issues or errors in the Exception workflow.

In this basic workflow, any documents that successfully pass GL Account Coding and Approval queues
are exported immediately. Those documents that fail Invoice Coding or Approval are sent to the Exception
queue. The corrected documents are sent to Validation.

Documents are processed by Kofax AP Agility in the following order.

Supported document types
Kofax AP Agility supports the following document types:
• Non-PO Invoices: Kofax AP Agility handles the GL Account Coding and Approval workflow processes

required for Non-PO invoices.
• Single PO Invoices: Includes Material and Services PO.
• Credit Memos: Kofax AP Agility processes credit memos and exports them.

Note Documents of undefined type proceed to the Exception workflow after Validation. An Exception
handler manually specifies the document type or cancels the document.

10



Kofax AP Agility Administrator's Guide

Architecture diagram
The following architecture diagram shows the Kofax AP Agility solution components and interaction
between them.
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Configure organization structure

Kofax AP Agility supports two levels of organizational hierarchy: organizations and business units.

This chapter describes how to modify and configure your organizations and business units using optional
setup features.

An organization is the largest hierarchical unit to represent your enterprise. Although you can create
multiple organizations in Kofax AP Agility, in general a single organization is sufficient. An organization
may correspond to a company, corporation, or legal entity, depending on the ERP system hierarchies.

Kofax AP Agility organizations correspond to Client ID in Kofax Invoice Processing Agility. Kofax AP Agility
associates IPA Client ID with the Kofax AP Agility organization to determine the organization that receives
an invoice after the import.

Organizations may be in active or inactive state in Kofax AP Agility. You can import invoices only
from active organizations to Kofax AP Agility. To set the organization active or inactive state, use the
organization configuration form.

Organizations comprise one or multiple business units. A business unit may correspond to an
organizational unit, department, or business unit, depending on the ERP system hierarchies.

Kofax AP Agility Business Units correspond to Company Codes in Kofax Invoice Processing Agility. Kofax
AP Agility uses the invoice Company Code field to determine the Business Unit that receives an invoice
after the import.

Business units may be in active or inactive state in Kofax AP Agility. Kofax AP Agility treats inactive
business units as business units that do not exist. To set the business unit active or inactive state, use the
organization configuration form.

The Kofax AP Agility installer adds a sample organizational structure to the Kofax AP Agility user
interface. APA Administrators configure organizations and business units according to their requirements.

The information about organizations and business units is stored in the Kofax AP Agility database. Each
organization and business unit is assigned to a unique ID for the identification in Kofax AP Agility.

Create ERP connection
Before setting up ERP connections, make sure that you have installed the ERP connector as shown in the
Kofax AP Agility Installation Guide.

1. Log on to the Kofax AP Agility as a user with administrator rights.
2. Select Configuration > ERP Connections.
3. On the ERP Connection form, click New.
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The ERP Connection: New form appears.

4. Complete the form by entering a name and description (optional) for the connection. Select the
connection type and the date as the starting point for loading data.
For more information about ERP integration, see the chapter Integration with Enterprise Resource
Planning systems .

5. Click Save.
A message indicates that the new ERP connection has been created.

6. Click Close.
The ERP Connection form appears with the new connection you created in the list.

GL account segment structure configuration
Before configuring Organizations and Business Units, you need to set up the GL Account Segment
Structure.

With Kofax AP Agility, you can set up the GL account segment structure and the validation rules for the
segment combinations that may be bound to organizations and business units.

Create the GL account segment structure
Kofax AP Agility lets the users create multiple GL Account segment structures.

The GL Account segment structure includes the following parameters.
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Parameter Description

Structure Name The name of the structure.
The parameter is required. The name must be unique for all segment
structures.

Description Optional information about the structure.

Segment Separator A character that is used in the GL Account string to separate segments.
The parameter is required.

List of Segments The list of GL Account segments in the structure. The maximum number
of segments supported in Kofax AP Agility is 15.
The parameter is required. To add a record to the list, select Segment
from the drop-down list, specify its Visible Name, and click Add.

Specify segment names and order in the GL Account for each segment. These segment names are
displayed on the GL Account coding interface.

1. On the AP Agility site, such as http(s)://<kta_server>/TotalAgility/Forms/APAgility
where <kta_server> is the Kofax TotalAgility server host name, click the Configuration menu item
and select GL Account Segment Structures.

2. On the GL Account Segment Structures form, click New.
3. Specify the structure name, description, and segment separator.
4. Click Save.

GL account segment structure configuration
A segment structure is configured independently from the organizations. For each Kofax AP Agility
organization, the segment structure is selected in the organization configuration (from the global list of
the segment structures). This segment structure is used to code invoices of all business units for this
organization.

With the list of segments, the Kofax AP Agility Administrator can create new structures, update and delete
segments. Segment structure cannot be deleted if Organization refers to the same segment structure.

Different organizations may use different GL Account segment structures.

1. On the Kofax AP Agility site, navigate to Configuration > GL Account Segment Structures.

2. Select a GL Structure to edit.

3. From the Segment drop-down list, select a Segment.

4. Specify Segment Visible Name.

5. Click Add.

6. Create the required number of segments.

7. Close the GL Account Segment Structures form.
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Segment values
The Kofax AP Agility AP Data Import job loads data files with the segment values and descriptions from
the ERP system. For information about master data import and configuring jobs, see ERP master data
import.

The segment values are displayed in auto-populated lists on the Choose GL Code form. The segment
value descriptions are displayed in the account description strings.
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Organizations configuration form
Kofax AP Agility users with APA Administrator rights are authorized to create and configure organizations.

1. On the AP Agility site, click the Configuration menu item and select Organization.
The Configuration menu item is available only to the APA Administrators Kofax TotalAgility group
members.

2. In the Organizations Kofax TotalAgility form, you can:
• Create and configure new organizations.
• Reconfigure existing organizations.
• Make organizations active or inactive.

Create an organization
Before creating organizations, you need to configure the ERP connection and GL Account Segment
Structure.

1. In the Organizations Configuration form, click New.
2. On the Organization tab, specify configuration settings for a new organization.
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3. Click Add to create an organization.

In order for invoices to be processed correctly through the workflow, do the following after you create an
organization:
• On the Business Units tab, create and configure business units for an organization. See Create a

business unit and  Business unit settings.
• On the Field Config tab, verify that the organization fields are correctly set up and click Update. See

Configure fields for an organization.

Organization settings
With Kofax AP Agility you can specify the following organization settings in the Organizations form.

Organization Settings Description

ERP Connection The ERP connection configured in Kofax AP Agility. Select the
connection from the list of configured connections.
The parameter is required.
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Organization Settings Description

Organization Name The name of the organization in Kofax AP Agility. The name may
differ from the organization name in the ERP system or Kofax Invoice
Processing Agility.
The parameter is required. The organization name must be unique. If
the organization name is taken, an error message appears.

Description Optional information about the organization.

ERP Organization ID An ID that the ERP uses to identify the organization. This setting is used
to associate the Kofax AP Agility organization with the corresponding
entity in ERP.
The parameter is required. ERP Organization Id must be unique for all
organizations within the same ERP connection. If the ERP Organization
Id is taken, an error message appears.

ERP Organization Name The organization name used in the ERP system.
The parameter is optional.

IPA Client Name The name of IPA Client associated with this organization. This name
will be used to associate the IPA client with the Kofax AP Agility
organization during the invoice import from Kofax Invoice Processing
Agility to Kofax AP Agility. A user must specify the name of an existing
Kofax Invoice Processing Agility client. Select the name from the list of
existing Kofax Invoice Processing Agility clients.
The parameter is required. IPA Client Name must be unique for all
organizations. If the IPA client name is taken, an error message
appears.
The organization configuration stores the IPA Client Id for the selected
client along with the name in the database.

GL Account Segment Structure The name of GL Account Segment Structure used for this organization.
Select the name of the segment structure from the list of structures
configured in Kofax AP Agility.
The parameter is required.
For more information, see GL Account Segment Structure
Configuration.

Active A flag enables users to make an organization active.

The following tabs are available after you create an organization:
• List of Business Units in Organization: Use to create or edit the configuration of business units

created in this organization.
• Field Configuration: Specifies which Kofax AP Agility fields are active for this organization.

Create a business unit
Configure business units per each organization. The Organizations Configuration form displays the list
of organization business units on the Business Units tab.

1. Select the Business Units tab and click New.
2. In the Business Units Configuration form, specify configuration settings for a new business unit.
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3. Click Add to create a business unit or Save if you are editing the business unit and close the form.

Business unit settings
With Kofax AP Agility you can specify the following business unit settings in the Business Unit
Configuration form.

Business Unit Settings Description

Business Unit Name The name of the business unit in Kofax AP Agility. The name may differ from
the business unit name in the ERP system.
The parameter is required. The business unit name must be unique. If the
business unit name is taken, an error message appears.

Description Optional information about the business unit.

ERP Business Unit ID An ID that ERP uses to identify the business unit. This setting is used to
associate the Kofax AP Agility business unit with the corresponding entity in
ERP.
ERP Business Unit ID is associated with IPA Company Code for an invoice to
determine which business unit it must be routed to.
The parameter is required. ERP Business Unit ID must be unique for all
business units within the same ERP connection. If the ERP Business Unit ID is
taken, an error message appears.
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Business Unit Settings Description

ERP Business Unit Name The business unit name used in the ERP system. This name may be used to
match IPA Company Code if it cannot be associated with ERP Business Unit
ID.
Specify ERP Business Unit Name if IPA Company Code matches the business
unit by the name (not by ID).
The parameter is optional.

Country Business unit country. Select the country from the list of countries defined in
Kofax AP Agility.
The parameter is required.

Currency Business unit base currency. Select the currency from the list of currencies
defined in Kofax AP Agility.
The parameter is required.

Auto Approval Level Specifies the largest invoice total amount that may be automatically approved
by Kofax AP Agility.

Use Approval Chain Follow a full approval chain for the configured Approval Hierarchy. If the
check box is not selected, the invoice is assigned to the first approver from
the approval hierarchy with the limit greater than or equal to the invoice total
amount.

Active A flag enables users to make a business unit active.

Email Approval A flag enables users to receive email notifications for invoices that need
approval.

Default Routing Order Select the order of applying Routing Options. The list includes the following
values:
• Vendor Groups
• Reason Code
• Vendor Naming Groups

Vendor Groups Arrange vendors into groups and assign the exception processor and GL
coding resources.

Vendor Naming Groups Group vendors by name and assign the exception processor and GL coding
resources.

Invalid Reasons Assign the exception processor resources according to the invalid reason for
an invoice from Kofax Invoice Processing Agility.

Configure fields for an organization
With Kofax AP Agility, you can make fields visible to a user or hide unnecessary fields. Activate fields
to use them for an Organization. Deactivate fields to maximize system performance for an Organization
where certain field processing is not required.

The list of active (visible in Kofax AP Agility) and inactive (not visible) fields in Kofax AP Agility may differ
from the Kofax Invoice Processing Agility fields list.
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Note The following fields are visible by default and used by the Exception form for the validation.

Changing the visibility settings for these fields requires the use of custom forms.
• Vendor ID
• Invoice Date
• Invoice Number
• Invoice Total
• Invalid Reason Code
• PO Number
• Lines Total

All fields listed on this tab can be shown on the invoice form. All active fields that are not included in
the form are imported from Kofax Invoice Processing Agility and exported to the ERP system without
changes.

The invoice validation step is skipped for inactive fields.

You can change the field configuration per each organization.

If you make changes to the field settings, the change is applied immediately to all invoices, including
invoices in progress. Before changing the field settings, verify that all invoices are processed till the end of
the workflow.

Note After you created an Organization, all fields will be shown on the invoice form, unless you open the
Field Config tab and click Update so that the selected values take effect.

Configure the Visible and Mandatory fields:

1. Select the Field Configuration tab.
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2. From the list, select a field to configure:
• Select and clear check boxes in the Is Visible and Is Mandatory columns.
• Specify Caption (visible name on the Invoice form).

3. Click Update to apply changes.

Remove organizations and business units
You cannot delete organizations. You can set organizations to an inactive state on the Organizations
form. Kofax AP Agility does not import invoices for inactive organizations.

For inactive organizations, disable the Send to AP Agility option in the Kofax Invoice Processing Agility
Solution Configuration Manager to avoid the export errors.

You cannot delete business units. You can set business units to an inactive state. Kofax AP Agility does
not route invoices to inactive business units. Also, Kofax AP Agility does not delete business unit data,
such as invoices, or configuration details for business units in inactive state. Invoices for inactive Business
Units move to the Administrator work queue in the exception state.
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Manage user roles

Note All Kofax AP Agility users need to be configured as Kofax TotalAgility resources.

Kofax AP Agility uses Kofax TotalAgility user management features. To create resources, groups and
control group membership, the Kofax AP Agility administrator uses the standard Kofax TotalAgility user
management forms.

The Kofax AP Agility package includes the APA Administrators Kofax TotalAgility group in the AP Agility
category.

Kofax AP Agility uses roles to permit members (resources) to access and perform privileged operations in
business units. The default Kofax AP Agility roles are:
• AP Managers: AP application group members that have administrative control.
• AP Processor: AP application group members that have responsibilities for specific vendors or vendor

groups.
• Approver: Members of a business level group responsible for approving invoices.
• Coder: Group members that are responsible for allocating non-PO invoice lines to the appropriate

financial accounting structure.
• Exception Processor: Group members perform processing of items flagged as requiring special

activities.
• AP Contacts: Group members are authorized to perform the Comment Request action.

Note You cannot create new roles or delete the existing ones.

One resource or one group may have multiple roles.

All Kofax AP Agility role owners may perform all privileged operations available to the roles they own.

Create a Kofax TotalAgility group
Kofax AP Agility associates a Kofax TotalAgility group with each role. The Kofax TotalAgility administrator
can control resources assigned to the role by changing the membership of the group associated with the
role.

We recommend that when you create a new Kofax TotalAgility group for each role in a business unit, and
specify the group name as follows:
• AP Managers - <Business Unit>
• AP Processor - <Business Unit>
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• Approver - <Business Unit>
• Coder - <Business Unit>
• Exception Processor - <Business Unit>
• AP Contacts - <Business Unit>

For the information about creating a Kofax TotalAgility group, see the Kofax TotalAgility Workspace Online
Help.

Privileged operations
With Kofax AP Agility, you can perform privileged operations for the selected invoices if you have the
appropriate authorization set up in the Kofax AP Agility role.

Privileged Operation Description

Escalate
(Available from Kofax Analytics for AP Agility)

Lets you move an invoice requiring attention from the
employee who retrieved it to the next person in the
approval hierarchy that is set up in Kofax AP Agility.

Increase priority Lets you increase the priority of any invoice that has an
associated Kofax AP Agility document.

Reassign Lets you assign an invoice assigned to oneself to a
different employee who has the correct authorization set
up in Kofax AP Agility.

Reassign all Lets you assign an invoice to a different employee who
has the correct authorization set up in Kofax AP Agility.

If a group has role permissions to perform the privileged operation, all members of this group can perform
this privileged operation. Enable a privileged operation for one or multiple roles. Manage a role to control
which privileged operations are available to the resources (users).

If a resource is assigned to multiple roles, the resource can perform a privileged operation if this operation
is enabled for at least one of these roles.

Configure role assignment
Before you proceed, verify that you configured organizations and business units.

Use the Business Unit Configuration form to assign roles to the Kofax AP Agility resources and groups
for the business unit and enable privileged operations to roles.

1. As a member of the APA Administrators group, navigate to Configuration > Organizations and
select an organization.

2. On the Business Units tab, select a business unit from the list.
3. On the Business Unit form, click Role Assignment.
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4. Associate the Kofax TotalAgility user groups or resources with the corresponding Kofax AP Agility
roles and privileges.

5. Click Save and close the form.

Set up approval hierarchy
Configure Approval Hierarchy as a part of the Business Unit Settings.

You can specify a single-chain or a multi-chain approval hierarchy within a Business Unit.
1. As a member of the APA Administrators Group, on the Kofax AP Agility site, navigate to

Configuration > Organizations and select an organization.
2. On the Business Units tab, select a business unit from the list of business units.
3. On the Business Unit form, click Approval Hierarchy.
4. On the Approval Hierarchy form, add an approver within the approval hierarchy chain:

a. In the Approver field, select the Kofax TotalAgility resources.

b. In the Limit field, set the approval limit value.

c. In the Next Approver field, select the Kofax TotalAgility resource.

d. Click Add.
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5. To add the final approver for the approval hierarchy chain:

a. In the Approver field, select Kofax TotalAgility Resource.

b. In the Limit field, set the value to: 0.00

c. Leave the Next Approver field blank.

d. Click Add.
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Special activity assignment rules

Use the information in this chapter to configure special rules that authorize resources to perform tasks.
• Vendor Groups rules
• Vendor Naming group rules
• Reason Codes rules

Vendor groups
Kofax AP Agility APA Administrators can configure vendor groups for business units.

Some ERP systems use a Vendor Group ID to arrange Vendors and assign AP processors to groups.
Vendor Group ID is used to make sure that the AP processor assigned to this group receives invoices for
processing, such as GL Coding or exception processing.

Kofax AP Agility lets you create and delete vendor groups, or add and remove vendors from the groups.
However, you cannot add one vendor to multiple groups.

Specify the resources that perform GL Coding and exception processing tasks for any group. You
can select users with the AP Processor role in the business unit to perform GL Coding and Exception
processing tasks for vendor groups.

1. Navigate to Configuration > Organizations and select an organization.

2. On the Business Units tab, select a business unit.

3. On the Business Units form, click Routing Options.

4. On the Vendor Groups tab, configure a vendor group for the selected business unit according to
your requirements.
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Vendor naming groups
Kofax AP Agility APA Administrators can configure vendor naming groups for business units.

You can group vendor names that begin with a specific character. The membership of each group must
be different. Otherwise, Kofax AP Agility processes invoices according to the rules of randomly selected
naming groups. Also, Kofax AP Agility does not verify if all vendor names are part of the naming groups.

Kofax AP Agility lets you create and delete vendor naming groups and assign naming ranges to them.

Specify the resources that perform GL coding and exception processing tasks for the naming group.
Each naming group may have different resources assigned and any group may have different resources
assigned for GL coding and exception processing tasks.

You can select users with the AP Processor role (or from the AP Processor group) in the business unit to
perform GL coding and exception processing tasks for vendor naming groups.

1. Navigate to Configuration > Organizations and select an organization.

2. On the Business Units tab, select a business unit.

3. On the Business Units form, click Routing Options.

4. On the Vendor Naming Groups tab, add, update, or delete groups for the selected business unit
according to your requirements.
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If vendor names start from a symbol that does not fall into any of the specified range, the general routing
rule is applied. All invoices from these vendors are assigned to the Exception processors or Coders of the
business unit.

Reason code
Kofax AP Agility lets customers assign resources to process exceptions according to the Invalid Reason
for invoices imported from Kofax Invoice Processing Agility. Invoices with different invalid reasons can be
processed by different resources.

To open the Reason Codes tab, navigate to Configuration > Organizations > Business Units, select a
business unit, and click Routing Options.

You can assign invoices with a certain invalid reason rule to members of the AP Processor group. If no
resources are assigned to an invalid reason, the invoice is assigned to all Exception Processors of the
business unit.
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Chapter 5

Integration with Enterprise Resource Planning
systems

Kofax AP Agility exports all validated and approved invoices to the Enterprise Resource Planning system
(ERP) through a connector plugin. Kofax AP Agility provides plugins for the following ERPs:
• PeopleSoft
• Infor Lawson

Agnostic ERP integration provides an ERP-neutral way of integration by transferring data to and from
folders. Kofax AP Agility Administrator specifies the output file system folder and the file name format for
exported invoices. The administrator creates an invoice image in the original format and metadata (XML,
CSV) files in the specified folder for all exported invoices.

The communication between Kofax AP Agility and ERP occurs independently via text and image files and
includes:
• Import of the ERP master data
• Export of the imported invoices to ERP

Prepare for ERP integration
Before setting up ERP connections, do the following:

1. Install the Agnostic ERP connector as shown in the Kofax AP Agility Installation Guide.
2. Configure the web.config file for the ERP connector to prepare for data import.

a. In the folder you created for the ERP Connector files, open the web.config file in a text editor.

b. Modify the file to indicate the paths to the .csv files used for data import.
<add key="EmployeeDataPath" value="" />
<add key="UomConversionDataPath" value="" />
<add key="TaxCodeDataPath" value="" />
<add key="MiscChargeAccountDataPath" value="" />

For the value, type the path and file name of the corresponding .csv files:
• EmployeeDataPath: employee.csv
• UOMConversionDataPath: uom_conversion.csv
• TaxCodePath: taxcode.csv
• MiscChargeAccount: misc_charge.csv

Here is an example:
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<add key="MiscChargeAccountDataPath" value="C:\ERPConnector\misc_charge.csv" /
>

c. Save your changes and close the web.config file.

ERP connection configuration
To open ERP Connections from the AP Work Queue form, navigate to Configuration > ERP
Connections.

Use the ERP Connections form to perform the following actions:
• View all ERP connections
• Add a new ERP connection
• Modify properties of the selected ERP connection, such as connection name (Agnostic ERP,

PeopleSoft v9.2, or Infor Lawson).
• Delete the selected ERP connection

You can create multiple ERP connections, and they can be from the same connector type. For each one,
give it a unique name.

To successfully configure the ERP connection on the ERP Connections form, verify the following:
• The connection name is filled in correctly.
• The connection name is unique for each ERP connection.
• The connection name is specified in web.config for the ERP connector.

Install PeopleSoft connector
If you have already installed the PeopleSoft ERP connector with Kofax Invoice Processing Agility, skip this
section.

If you are using the PeopleSoft ERP system, it is necessary to install this connector in addition to the
Agnostic ERP connector. You cannot install this connector without the Agnostic ERP connector.

Install the PeopleSoft ERP connector by following these steps.
1. Download the KofaxInvoiceProcessingERPConnector-1.1.0_For_PeopleSoft.ZIP from the Kofax

Fulfillment Site and extract it on a local drive available to your users.
2. Copy the contents in the ERP Connector\bin folder from the extracted files to the ERP

Connector\bin location in IIS where you copied the Agnostic ERP connector files.

PeopleSoft integration
To integrate PeopleSoft with Kofax AP Agility, install the KOFAX_CONNECTOR project in PeopleSoft
Application Designer, create an ERP connection, assign it to the organization, and configure the ERP
connector service in web.config. Follow these steps:

1. Start PeopleSoft Application Designer.
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2. Extract the KofaxConnector_For_PeopleSoft.zip file.

a. Navigate to the ERP_Integration\PeopleSoft folder where Kofax AP Agility is extracted.
The folder contains the KofaxConnector_For_PeopleSoft.zip file.

b. Extract KofaxConnector_For_PeopleSoft.zip.
The KOFAX_CONNECTOR folder is extracted. You will use this to copy the project.

3. Select Tools > Copy Project > From File.
The Copy From File : Select Project window appears.

4. Select the KOFAX_CONNECTOR project and options from the Copy From File : Select Project
window. Do the following:

a. Navigate to the KOFAX_CONNECTOR folder you extracted and select it.
Under Name, KOFAX_CONNECTOR appears, and KOFAX_CONNECTOR appears under
Select Project from the List Below.

b. Click Select to the right of the Select Project from the List Below box.
The Copy From File window appears.

c. Click Select All to select all definition types.

d. Click Copy.
The project and its definition types are installed.

5. Open PeopleSoft in a compatible web browser and configure KOFAX_APA_SERVICE. Do the
following:

a. Go to PeopleTools > Integration Broker > Integration Setup > Services.

b. Open KOFAX_APA_SERVICE.
Information about KOFAX_APA_SERVICE and a list of service operations appears.

c. Open one of the KOFAX_APA_SERVICE service operations and click Service Operation
Security.

d. Set the PTPT1000 permission to Full Access and click Save.

e. Repeat steps 5.c–5.d until all of the KOFAX_APA_SERVICE service operations have been
configured.

6. Create the ERP connection as shown in Create ERP connection. Complete the information in the
fields. In the Connection Type field, select PeopleSoft v9.2.

7. Set up the organization to use the ERP connection as shown in Organization settings.
8. Modify web.config. Under <configuration><erpConnector><connections>, add <connection> and

subelements to define the connection:
<connection name="PeopleSoft" type="PeopleSoft">
        <add name="url" value="https://peoplesoft:8443/PSIGW/
PeopleSoftServiceListeningConnector/PSFT_EP"/>
        <add name="username" value="VP1" />
        <add name="password" value="vp1" />
        <add name="page_size" value="10000"/>
      </connection>

For <connection>, the name attribute must match the name of the ERP connection defined in Kofax
AP Agility.
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For each of the <add> elements, provide the following values for these attributes:
• url: Enter the URL to the PeopleSoft web service.
• username and password: Enter the authentication for the PeopleSoft web service
• page_size: Enter a positive integer with the count of master data records that will be returned by

web service during each call.
For example, if page_size is equal to 1000 and the number of vendors in PeopleSoft ERP is 5000,
the PeopleSoft ERP plugin makes 5 requests to the web service. Each time, the web service
returns 1000 records of data.

Note If you need to use HTTP, modify web.config to disable SSL. Under
<configuration><system.serviceModel><bindings><binding>:
<binding name="KOFAX_APA_SERVICE_Binding" maxReceivedMessageSize="2147483647">
          <readerQuotas maxDepth="2147483647" maxStringContentLength="2147483647"
 maxArrayLength="2147483647" maxBytesPerRead="2147483647"
 maxNameTableCharCount="2147483647"/>
          <security mode="Transport" />
        </binding>

Delete the <security> element. The <connection> element should be the same as shown in step 8.

PeopleSoft invoice export
Additional settings are needed to enable invoice export from PeopleSoft. The ChartFields settings are
used for GL segments for invoices. If the buyer does not have access to the ChartFields settings, GL
segment values from exported invoices are ignored and replaced by default values. To enable buyers to
access these settings, modify the settings as shown in this procedure.

1. Start PeopleSoft.
2. In the PeopleSoft menu, select Navigator > eSettlements > Buyer Information > Review Buyer

Details.
3. Select the buyer who should have access.

The Review Buyer Details window for that buyer appears.
4. Click the ChartField Configuration tab.
5. Change the Supplier Access settings for the buyer to make applicable GL segments editable. Save

the settings.

Install Infor Lawson connector
If you have already installed the Infor Lawson ERP connector with Kofax Invoice Processing Agility, skip
this section.

If you are using the Infor Lawson ERP system, it is necessary to install this connector in addition to the
Agnostic ERP connector. You cannot install this connector without the Agnostic ERP connector.

Install the Infor Lawson ERP connector by following these steps.
1. Download the KofaxInvoiceProcessingERPConnector-1.1.0_For_Lawson.ZIP from the Kofax

Fulfillment Site and extract it on a local drive available to your users.
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2. Copy the contents in the ERP Connector\bin folder from the extracted files to the ERP
Connector\bin location in IIS where you copied the Agnostic ERP connector files.

Infor Lawson integration
To integrate Infor Lawson with Kofax AP Agility, follow these steps:

1. Create the ERP connection as shown in Create ERP connection. Complete the information in the
fields. The following settings are required.
• In the Connection Type field, select Infor Lawson.
• In the Start Data Load From, a starting date is required.

2. Set up the organization to use the ERP connection as shown in Organization settings.
3. Integrate the Infor Lawson with Kofax AP Agility by following these steps:

a. Verify that prerequisites for Infor Lawson integration are complete.

b. Create the Infor Lawson web service.

c. Configure the Infor Lawson web service.

d. Configure the Infor Lawson connection settings.

e. Review information about Infor Lawson data import and export configuration.

f. Configure the AGS invoice export (optional).

g. Adjust the Master data retrieval configuration (optional).

h. Review Lawson AGS invoice export mapping for the header.

i. Review Lawson AGS invoice export mapping for the lines.

Prerequisites for Lawson integration
Before you can configure the Lawson connector, the following prerequisites are necessary.

1. The user defined when you create the web service requires READ permissions for the following
Lawson tables.
• APVENLOC

• APINVOICE

• PORECLINE

• GLCHARTDTL

• APVENMAST

• TERMS

• APCOMPANY

• ACACTIVITY

• POLINE

• APPAYMENT

• GLSYSTEM

• ACACCTCAT

• PURCHORDER
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• MAINVDTL

• GLNAMES

2. The configured user also requires ADD, CHANGE, and DELETE access for the following screens.
• AP20.2
• MA43.1
• MA43.3

3. .NET 4.5.2 is required in order to use the Lawson connector.

Create Lawson web service
Before you can make use of the Lawson ERP Connector, it is necessary to create the web service using
the files provided.

You can create the Lawson web service by following these steps.
1. Install the Lawson ERP connector.

a. In the unzipped files, navigate to the ERP Integration\Lawson folder.
The KofaxConnector_For_Lawson.zip file is displayed.

b. Extract KofaxConnector_For_Lawson.zip.
You can provide your own folder name or use the default name provided during extraction.
The folder is extracted. Use this to copy the project.

c. Copy the extracted folder from the previous step to a location that is accessible by IIS.
For example, C:\inetpub\wwwroot.

2. Launch IIS.
3. In the Connections pane, expand http://localost represented by your computer name.

A list of Application Pools and Sites is displayed.
4. Select and then right-click on Sites. Select Add Website.

The Add Website window opens.
5. In the Add Website window, enter the following information.

a. In the Site name field, enter a name for your web service.
For example, KTA Lawson Connector.

b. For the Application Pool, click Select and then choose .NET v4.5 from the list.

c. In the Physical Path, click on the Browse button and navigate to and select the folder you
copied in step 1 b.

d. Configure the other settings as required.
For example, set the Binding Port to 9810.

e. Ensure that the Start Website immediately option is selected and then click OK.
The website is created and listed under Sites.

6. Select your newly created website.
The central Home pane is updated for your site.

7. In the central Home pane, under IIS, double-click on Authentication.
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The Authentication settings are displayed.
8. Ensure that Basic Authentication is enabled.

If necessary, right-click on Basic Authenitcation and select Enable.
If you cannot find Basic Authentication in your website, make sure that Basic Authentication is
enabled in IIS by following these instructions.
https://docs.microsoft.com/en-us/iis/configuration/system.webserver/security/authentication/
basicauthentication.
A warning message is displayed because you are not using an SSL.

9. Enable SSL for your website as follows.

a. In the Connections panel, right-click on your website and select Edit Bindings.
The Site Bindings window is displayed.

b. In the Site Bindings window, click Add.
The Add Site Binding window s displayed.

c. In the Add Site Binding window, specify the following.
Set Type to https.
• Set the Port to any available port.
• Set the SSL certificate to a valid certification.

d. Click OK.
Your newly added binding is listed on the Site Bindings window.

e. Click Close.
The Site Bindings window is closed.

Your website is now configured for SSL connections.
10. Test your installation as follows.

a. Edit the website Web.config file so that the KtaService:UseMockData setting is set to true.

b. In a web browser go to https://localhost:<port number>/testConection.
Where <port number> matches the port you specified in step 10 c.

c. When prompted, enter the Username and Password for any Windows user.
If the connection is successful, the following is displayed.
<?xml version="1.0"?>
<ConnectorTestStatus xmlns="http://schemas.datacontract.org/2004/07/
KtaConnector.Services" xmlns:i="http://www.w3.org/2001/XMLSchema-instance">
  <AdditionalInformation/>
  <ErrorCode>NONE</ErrorCode>
  <IsSucceeded>true</IsSucceeded>
  <Message/>
</ConnectorTestStatus>

If the testing fails, review the previous steps and try again.
Your web service website is ready for configuration.

Configure Lawson web service
Now that the web service is installed and its connection string is referenced in the web.config file, it is
necessary to configure the web service.
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You can configure the Lawson web service by following these steps..
1. Restart the Lawson web service that you recently created.
2. Navigate to the Lawson web service <serviceFolder>/Services/Connectors/Lawson/lib

folder and open the RPILawsonCOM_Config.xml file for editing.
3. In the RPILawsonCOM_Config.xml file, edit the following parameters.

Parameter Name Description and Examples

LawsonAuth The authentication method.
Choose between one of the following two authentication types.
• PREMISES - Enter this value if you are using Kofax AP Agility on-

premise.
• CLOUD - Enter this value if you are using Kofax AP Agility in an Azure

environment.

Username The username of the Lawson user used by the connector for
authentication.

Password The password of the Lawson user used by the connector for
authentication.

ProductLine The product line to use when querying Lawson.

LawsonDMEPath The relative path to the Lawson data servlet.
For example, "/servlet/Router/Data/Erp?".

LawsonAGSPath The relative path to the Lawson transaction servlet.
For example, "/servlet/Router/Transaction/Erp?".

LawsongWriteAttachPath The relative path to the Lawson writeAttach executable.
For example, "/cgi-lawson/writeattache.exe".

LawsonGetAttachPath The relative path to the Lawson getAttach execuatble.
For example, "/cgi-lawson/getattachrec.exe".

LawsonBaseURL The base URL where Lawson is listing for requests.
For example, https://100.11.12.13.

If you are using Kofax AP Agility in an Azure environment, also edit the following cloud-specific
parameters.

Parameter Name Description and Examples

LandmarkBaseURL The URL of the landmark instance that the Lawson connector uses for
authentication.

CloudAdfsUrl The URL that is used in the third step of the Lawson connector
authentication process.

CloudBaseUrl The URL that is used in the fourth step of the Lawson connector
authentication process.

4. Save and then Close the RPILawsonCOM_Config.xml file.
5. Open the web.config file for editing. This file was created when you created the web service.
6. Edit the web.config file so that the KtaService:UseMockData setting is set to false.

This ensures that the web service no longer uses mock data.
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7. Save and Close the web.config file.
Your Lawson web service is now ready for use.

Configure the Lawson connection settings
Now that the web service website is available, configure the web.config so that it points to the newly
added web service.

You can configure the Lawson connection string by following these steps.
1. Open the Kofax AP Agility Workspace.
2. Create an Lawson ERP connection as shown in #unique_54.
3. Add an organization to use the above ERP connection as shown in #unique_55.
4. Locate the web.config file in the web folder used by the ErpConnector service and open it with a text

editor.

a. Under <configuration><erpConnector><plugins> locate the <plugin> with the type
Lawson.
Ensure that the default plugin is as follows:
<plugin type="Lawson"
 class="Kofax.ApAgility.ErpConnector.Plugins.InforLawson.InforLawsonErpPlugin,
 Kofax.ApAgility.ErpConnector.Plugins.InforLawson, Version=1.0.0.0,
 Culture=neutral, PublicKeyToken=0a00a7449ea4c480"/>

Note There can be one Lawson plugin only.

b. Under <configuration><erpConnector><connections> add a <connection> element
and sub-elements for your Lawson ERP connection as follows.
<connection name="Lawson" type="Lawson">
   <add name="url" value="https://localhost:9443"/>
   <add name="authentication_type" value="Basic"/>
   <add name="username" value="LawsonAdmin"/>
   <add name="password" value="password"/>
   <add name="page_size" value="1000"/>
   <add name="zip" value="1"/>
</connection>

For the <connection>, the name attribute must match the name of the ERP connection
defined when you added the ERP connection.
The type attribute in <connection> should match the type attribute in <plugin>.
For each of the <add> elements, provide the following values.
• url: Enter the URL to the Lawson service.
• authentication_type: Enter either Basic or Windows. If you specify Basic, enter the

username and password attributes. If you enter Windows, leave username and password
empty.

• page_size: Enter a positive integer with the mount of master data records that are returned
by the web service for each call.
For example, if page_size is set to 1000 and the number of vendors in the Lawson ERP
is 5000, the Lawson ERP plugin makes 5 requests to the web service. Each time the web
service returns 1000 records of data.
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• zip: Enter 1 to have the Lawson service compress archive data before it is returned. Enter 0
to leave the archive data uncompressed.

Note The paths specified here must be accessible to Kofax AP Agility

c. Save the web.config file.

Lawson data import and export configuration
The Lawson connector uses the Lawson Data Service (DME) to retrieve AP master data. It also uses the
Lawson Application Gateway Service (AGS) to export invoice data into Lawson. The DME queries are
defined in the RPILawsonCOM.config.xml file.

The AGS scripts are used to export NON-PO, credit, and PO-based invoices.

The DME queries and AGS calls are adjustable based on your requirements and how Lawson is
configured.

By default, import and export have a default configuration. However, you can adjust these settings as
needed for your installation.

Master data retrieval configuration
Lawson Data Service (DME) is a service that provides dynamic, read-only access to Lawson data. When
a user makes a request from the Lawson Portal or another location, DME makes calls to the database and
returns the requested data ensuring that the security rules are enforced. DME retrieves data and sends
it back to the requesting client. By default, the format of the data sent back is XML. However, this can be
modified to CSV format if necessary.

This data retrieval does not support data updating.

Note After a configuration change restart the Lawson web service for the change to take effect.

Data query configuration
File Location:  \Services\Connectors\Lawson\lib\RPILawsonCOM_config.xml
DME queries specified in the config file should not be edited in most cases. However, there are some
cases were it may be necessary to adjust the configuration. Specifically, it may be necessary to update
the SELECT clause in the DME query to filter results or add additional customer user fields that re
used. Existing data columns should not be removed. DME queries must be URL encoded in the XML
configuration file.
Vendors query example.
<item key="APVenMast">
   <Query QueryMode="Xml">
    <QueryURL>FILE=APVENMAST&amp;FIELD=VENDOR%2DSNAME;TAX%2DID;REMIT%2DTO
%2DCODE;VENDOR;VENDOR%2DGROUP;VENDOR%2DVNAME;VDR%2DADDR1;VDR%2DADDR2;VDR%2DCITY
%2DADDR5;VDR%2DCOUNTRY;VDR%2DPOSTAL;VDR%2DSTATE;VAT%2DREG%2DCTRY;VAT%2DREG%2DNBR;BANK
%2DID;VBANK%2DACCT%2DNO;E%2DMAIL%2DADDRESS;PHONE%2DNUM;VENDOR%2DCONTCT;BANK
%2DENTITY;VDR%2DADDR3;DISC%2DCALC%2DDATE;INV%2DCURRENCY;BANK%2DINST%2DCODE;CASH
%2DCODE;VAT%2DREG%2DCTRY;REQUIRE%2DPO;TERM%2DCODE;URL%2DADDR&amp;SELECT=VENDOR%2DGROUP
%3DVEN%7CVENDOR%2DGROUP%3D4321&amp;OUT=XML&amp;NEXT=TRUE&amp;{0}</QueryURL>
   </Query>
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  </item>

Adding data filtering to the DME queries
In the Vendors query example above we can see that there is filtering applied with a SELECT statement in
the query.
"SELECT=VENDOR%2DGROUP%3DVEN%7CVENDOR%2DGROUP%3D4321"

This is a URL encoded version for  "SELECT=VENDOR-GROUP=VEN|VENDOR-GROUP=4321".
For more information, see the Lawson Doc for Developers: IOS Application Program Interfaces.
Invoices query example.
<item key="APInvoice">
   <Query QueryMode="Xml">
    <QueryURL>FILE=APINVOICE&amp;FIELD=APPAYMENT%2ECHECK%2DDATE;APPAYMENT%2EVOID
%2DDATE;APPAYVENMAST%2EVENDOR%2DSNAME;APPAYVENMAST%2EREMIT%2DTO%2DCODE;OBJ
%2DID;VENDOR;COMPANY;INVOICE;CANCEL%2DDATE;INVOICE%2DDTE;INVOICE%2DTYPE;BASE%2DINV
%2DAMT;PO%2DNUMBER;REC%2DSTATUS;APPAYVENMAST%2EVENDOR;&amp;OUT=XML&amp;NEXT=TRUE&amp;
{0}</QueryURL>
   </Query>
  </item>

In the Invoices query above there is no SELECT clause. This means that for the specific Lawson instance,
no filtering is required. A SELECT clause can be added if necessary.

AGS invoice export configuration
The AGS Export uses the XSLT 1.0 transform the incoming XML from Kofax into a set of transactions
required to process invoices in Lawson. See Lawson AGS export mapping - Invoice Header fields and
Lawson AGS export mapping - Invoice Line fields for additional mapping details.

Note After a configuration change restart the Lawson web service for the change to take effect.

NON-PO/CREDIT Transaction
File Location: \Services\Connectors\Lawson\lib\Invoice_Add_NonPO.xslt.
Example 1.
<API-INVOICE>
      <xsl:value-of select="translate(InvoiceNumber,'abcdefghijklmnopqrstuvwxyz',
'ABCDEFGHIJKLMNOPQRSTUVWXYZ')"/>
     </API-INVOICE>

Example 2.
<API-INVOICE-TYPE>
      <xsl:if test="DocumentType = 'CREDIT'">C</xsl:if>
      <xsl:if test="DocumentType != 'CREDIT'"></xsl:if>
     </API-INVOICE-TYPE>

PO Match Transaction
File Location: \Services\Connectors\Lawson\lib\Invoice_Add_PO.xslt.
Example 1.
<PT-MAD-LINE-NBR><xsl:value-of select="substring-after(GrDocNo,'-')"/></PT-MAD-LINE-
NBR>

Example 2.
<MAD-ENTERED-QTYr0><xsl:value-of select="Quantity"/></MAD-ENTERED-QTYr0>
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Lawson AGS export mapping - Invoice Header fields
The following table explains the invoice header export fields used by the Lawson AGS.

Tag Description Lawson API
Field

Interface
Notes

Invoice The root XML tag

Invoice/AccountNumber The account number field has a unique
identification number for a client from the vendor
point-of-view. See IPA Administration Guide for
additional information.

N/A N/A

Invoice/AlternatePayee This field is a supplementary field to the Vendor
ID. It represents the party that receives invoice
payments, and is not necessarily the vendor
listed on the invoice. This payee must be on
a list of pre-defined permitted payees for the
extracted Vendor. See IPA Administration Guide
for additional information.

N/A Lawson
Handles
"Payment
Vendor"
in internal
setup and not
during Invoice
Creation

Invoice/AlternatePayeeAddress Not used for export in ERP. N/A N/A

Invoice/AmtMiscellaneous Not used for export in ERP. N/A N/A

Invoice/AmtWithholdingTax The withholding tax amount fields capture the
portion of the invoice total that is withheld by the
client for legal reasons and not paid back to the
vendor.

N/A N/A

Invoice/AmtPst This field captures the Provincial Sales Tax
(ProvincialSalesTax/QST) component of
Canadian tax.

N/A N/A

Invoice/ApproveTime Time when the invoice has been approved in
APA

N/A N/A

Invoice/ApproverName Approver name who approved the invoice in
APA

N/A N/A

Invoice/BankAccount The bank account number captures where the
vendor wants to be paid.

N/A Handled
in Lawson
Vendor Setup
not during
Invoice
Creation

Invoice/BankAccountCode The bank account code represents the
identification of the bank account for that vendor
from the point-of-view of the downstream ERP
system.

N/A Handled
in Lawson
Vendor Setup
not during
Invoice
Creation

Invoice/BIC The BIC or SWIFT code is an internationally
assigned code to identify a unique banking
institution.

N/A N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/BillToName This field represents the name of the invoice
recipient. This field is used to check that the
incoming document is intended for a valid
company within a client organization.

N/A N/A

Invoice/BillToVatRegNo The Vendor VAT Registration Number and Bill-to
VAT Registration Number are available to satisfy
a European legal/fiscal compliance ruling. This
law states that if value added tax is charged, the
vendor must state their VAT registration number
as well as the VAT registration number of the bill-
to party on the invoice.

N/A N/A

Invoice/BusinessUnitID ID of the invoiced business unit. API-
COMPANY

REQUIRED

Invoice/Currency This field contains the ISO-code of the invoice
currency. (USD, GBP, EUR, etc.)

API-INV-
CURRENCY

Invoice/Custom1 Not used for export in ERP. N/A

Invoice/Custom2 Not used for export in ERP. N/A

Invoice/Custom3 Not used for export in ERP. N/A

Invoice/Custom4 Not used for export in ERP. N/A

Invoice/Custom5 Not used for export in ERP. N/A

Invoice/DeliveryDate This field captures the delivery date for the
goods or services stated on the invoice.

N/A

Invoice/DeliveryNote This field captures the vendor delivery note
number if one is found on the invoice.

N/A

Invoice/Discount This field captures a discount given by the
vendor. See IPA Administration Guide for
additional information.

N/A Driven by
Payment terms
Code logic

Invoice/DiscountDueDate Not used for export in ERP. N/A

Invoice/DocumentType INVOICE, CREDIT. This field indicates if the
incoming document is an invoice or a credit
memo.

API-INVOICE-
TYPE

Logic in export
mapping
to set this
value to "C" if
DocumentType
= "CREDIT"
Other wise
Blank (Invoice)
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Tag Description Lawson API
Field

Interface
Notes

Invoice/DueDate This field captures the due date for payment. API-DUE-
DATE

If the vendor or
location does
not have a
payment terms
code assigned
and you do
not assign
a payment
terms code to
the invoice,
this field is
required

Invoice/EmployeeID This field contains the identification number for
the user name of an employee found on the
document. This field can be used downstream
in the workflow to route the document to the
relevant person in your organization. For
example, for invoice coding and approval.

N/A N/A

Invoice/EmployeeIndexNumber Not used for export in ERP. N/A N/A

Invoice/EmployeeName This field contains the user name of an
employee found on the document. This field can
be used downstream in the workflow to route
the document to the relevant person in your
organization. For example, for invoice coding
and approval.

N/A N/A

Invoice/ExchangeRate Not used for export in ERP. N/A N/A

Invoice/Freight This field captures a freight charge specified
by the vendor at the header level. Freight is
typically captured at the line-item level.

N/A Mapped at the
Line Level

Invoice/HarmonizedSalesTax This is a type of sales tax (HarmonisedSalesTax)
adopted by many Canadian provinces
that combine the traditional Goods and
Services Tax (GST) and Provincial Sales Tax
(ProvincialSalesTax) into a single tax amount.

N/A N/A

Invoice/Iban This number represents the international bank
account number invoice payment. It is extracted
by the system in partnership with the BIC code.

N/A N/A

Invoice/Icms ICMS tax is a form of sales tax that is applied
to material items in Brazil. When extracted, the
system converts this to a valid amount using
a period as the decimal separator. See IPA
Administration Guide for additional information.

N/ A N/A

Invoice/InvalidReason Not used for export in ERP. N/A N/A

Invoice/InvoiceDate Invoice date API-DISTRIB-
DATE

API-DISTRIB-
DATE
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Tag Description Lawson API
Field

Interface
Notes

Invoice/InvoiceNumber The invoice number is a unique identifier for a
document, from the point-of-view of the supplier.

API-INVOICE

Invoice/InvoiceType PO, NON-PO. This field indicates if an invoice is
a purchase order (PO) or a non-purchase order
(NON-PO).

N/A N/A

Invoice/IpaClientName Not used for export in ERP. N/A N/A

Invoice/IsrRetention The ISR Retention (Impuestos sobre la Renta)
field is used to capture the ISR retention
component to withhold tax. This field can
appear on Mexican invoices. The IVA retention
component is captured in the regular withholding
tax field.

N/A N/A

Invoice/LocalVatAmount Not used for export in ERP. N/A N/A

Invoice/MexicanUuid This field is an invoice number that is provided
by the Mexican SAT authorities. It appears as
a standard field on electronic documents. It is
36 characters long and must be captured for
government reporting purposes.

N/A N/A

Invoice/NetAmount0 This field contains the extracted amounts on the
document that have a tax rate of zero.

N/A N/A

Invoice/NetAmount1 This field captures an invoice subtotal amount
and it forms part of the Invoice Total. See IPA
Administration Guide for additional information.

N/A N/A

Invoice/NetAmount2 These fields contain the extracted amounts
on the document that have tax rates specified
in TaxRate2-TaxRate4 fields. See IPA
Administration Guide for additional information.

N/A N/A

Invoice/NetAmount3 N/A N/A

Invoice/NetAmount4 N/A N/A

Invoice/OrganizationName The name of the invoiced organization in ERP N/A N/A

Invoice/OrganizationId ID of the invoiced organization in ERP N/A N/A

Invoice/PaymentReference This field captures vendor payment references
specified on an invoice.

N/A N/A

Invoice/PoExtension The PO Extension field is populated in
implementations involving JD Edwards
or PeopleSoft only. In JD Edwards
implementations, this field contains the purchase
order type. In PeopleSoft implementations, this
field contains the purchasing business unit.

N/A N/A

Invoice/PoNumber Purchase order number. Valid only for PO
invoices.

API-PO-
NUMBER

N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/PorNumber The payment order reference (POR) number
is a 27-character transaction ID applied to the
invoice by the Swiss Postal Service. See IPA
Administration Guide for additional information.

N/A N/A

Invoice/PorSubscriberNo The payment order reference (POR) subscriber
number. See IPA Administration Guide for
additional information.

N/A N/A

Invoice/PoType MATERIAL, SERVICE. This field indicates if an
extracted purchase order relates to materials
or services. See IPA Administration Guide for
additional information.

N/A Static Value
Used to
determine the
type of Export.
Not Mapped

Invoice/SiteID Vendor site ID. API-REMIT-
TO-CODE

N/A

Invoice/TaxAmount1 These fields contain the tax amounts for
their corresponding Net Amounts. See IPA
Administration Guide for additional information.

API-TRAN-
TAX-AMT

N/A

Invoice/TaxAmount2 N/A N/A

Invoice/TaxAmount3 N/A N/A

Invoice/TaxAmount4 N/A N/A

Invoice/TaxRate1 These fields contain the tax rates for their
corresponding Net Amounts. See IPA
Administration Guide for additional information.

N/A N/A

Invoice/TaxRate2 N/A N/A

Invoice/TaxRate3 N/A N/A

Invoice/TaxRate4 N/A N/A

Invoice/InvoiceAmount This field contains the total amount due for
payment on the current invoice.

API-TRAN-
INV-AMT

REQUIRED

Invoice/VendorCity Not used for export in ERP. N/A N/A

Invoice/VendorId Vendor ID API-VENDOR REQUIRED

Invoice/VendorIndexId Not used for export in ERP. N/A N/A

Invoice/VendorName1 Not used for export in ERP. N/A N/A

Invoice/VendorStreet1 Not used for export in ERP. N/A N/A

Invoice/VendorStreet2 Not used for export in ERP. N/A N/A

Invoice/VendorVat Not used for export in ERP. N/A N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/VendorVatRegNo The Vendor VAT Registration Number and Bill-to
VAT Registration Number are available to satisfy
a European legal/fiscal compliance ruling. This
law states that if value added tax is charged, the
vendor must state their VAT registration number
as well as the VAT registration number of the bill-
to party on the invoice.

N/A N/A

Invoice/VendorZip Vendor ZIP code N/A N/A

Invoice/YourRef Use this field to capture a reference number
specified on the invoice that relates to the
billable party. It can often consist of a contact
name, a reference number, or a combination of
both.

N/A N/A

Invoice/PasswordCn This field is used for domestic VAT invoices on
Mainland China and refers to the encrypted 4-
line coding block that appears in the top-right
hand quadrant of the invoice document.

N/A N/A

Invoice/InvoiceCodeCn This field is used for domestic VAT invoices on
Mainland China. It refers to the ten digit numeric
code that habitually appears in the top-left hand
corner of the document.

N/A N/A

Invoice/EcmDocumentId Document ID in the enterprise content
management system where the document has
been exported to (for ECM integration).

N/A Would be
custom
mapped
for each
implementation

Invoice/DocumentLink Document ID in ECM where the invoice was
exported to by APA.

N/A Would be
custom
mapped
for each
implementation

Invoice/ErpPoType Not used for export in ERP. N/A N/A

Invoice/ScanDate Invoice import (or scan) time. N/A N/A

Invoice/SubTotal Not used for export in ERP. N/A N/A

Invoice/Urn Unique archive document ID (for early archiving
scenarios).

N/A N/A

Invoice/IpaInvalidReasonCode Not used for export in ERP. N/A N/A

Invoice/IpaInvalidReasonRule Not used for export in ERP. N/A N/A

Invoice/IpaOrganizationName Not used for export in ERP. N/A N/A

Invoice/IpaOrganizationId Not used for export in ERP. N/A N/A

Invoice/PaymentComments Not used for export in ERP. N/A N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/PaymentMethod Payment method. N/A Defaulted
by Vendor in
Lawson

Invoice/ImageExtension Invoice image file name extension (depends on
the image type, for example, .tiff, .pdf, etc.)

N/A Documents
are not
exported to
Lawson

Invoice/ImageBase64 Base64 encoded invoice image N/A Documents
are not
exported to
Lawson

Lawson AGS export mapping - Invoice Line fields
The following table explains the invoice line export fields used by the Lawson AGS.

Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem Root for a line item Lawson API
Field

Interface
Notes

Invoice/LineItem/Category Miscellaneous charge category applied to the
invoice line item based on the extracted line item
description.

N/A N/A

Invoice/LineItem/Description Invoice line item description. If the line item is
paired, this description appears on the purchase
order. If the line is unpaired, this field contains
the raw text description that was read from the
invoice. For third-party freight invoices, service
invoices, and MIRA invoices where no line
items were required in the TAB section, and line
pairing was either unsuccessful for any lines,
or was not carried out, the description is set to
THIRD PARTY FREIGHT, SERVICE and MIRA
respectively.

N/A N/A

Invoice/LineItem/Discount Not used for export in ERP. N/A N/A

Invoice/LineItem/LineNumber Line number (1..N) MAD-LINE-
NBRr0

Each line is
added to the
first Row
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Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem/LineType One of: Item, Sales Tax, Misc. Tax, Freight,
Misc. Charge. See IpaLineType below

N/A Not mapped,
but when used
would drive
different logic
for the line
depending on
the Type of
Line..MISC
add on cost vs
SPREAD add
on cost vs TAX

Invoice/LineItem/
MeterialNumber

Invoice line item material number. If the line
item is paired, this is populated with the material
number from the purchase order line item. If
the line is not paired, this is populated with any
values read from the invoice.

N/A N/A

Invoice/LineItem/
OriginalLineNumber

Not used for export in ERP. N/A N/A

Invoice/LineItem/PoNumber The purchase order number, and is populated
only if line pairing is successful for this item.

AOI-PO-
NUMBER

N/A

Invoice/LineItem/Quantity The invoice line item quantity. MAD-
ENTERED-
QTYr0

Each line is
added to the
first Row -
Only used in
PO

Invoice/LineItem/Total The invoice line item total. N/A Not mapped -
calculated in
Lawson based
on unit price X
quantity

Invoice/LineItem/UnitPrice The invoice line item unit price and it is only
populated for unpaired line items. In all other
cases, it has a value of zero.

MAD-ENT-
UNIT-CSTr0

Only used on
PO invoices

Invoice/LineItem/
UnitOfMeasure

Unit of measure. ENT-BUY-
UOM

N/A

Invoice/LineItem/UnitOfQuantity Unit of quantity. N/A N/A

Invoice/LineItem/TaxAmount Tax amount MISC-INV-
AOC-AMTr0

Used in
Conjunction
with an add on
cost code - PO
Invoice Only

Invoice/LineItem/TaxRate Tax rate Invoice line item tax rate. The
percentage rate of tax applied to the invoice line
item. If no percentage tax rate at line item level
can be ascertained, then this value is blank.

N/A N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem/ChargeCode Invoice line item charge code. This is lifted from
the purchase order line item to which an invoice
line is paired.

N/A N/A

Invoice/LineItem/ChargeCodeId Invoice line item charge code ID (only for PO-
matched lines). This is lifted from the purchase
order line item to which an invoice line is paired.

N/A N/A

Invoice/LineItem/
CompanyCode

Company code that corresponds to a line item.
This is lifted from the purchase order when an
invoice line is paired.

N/A N/A

Invoice/LineItem/ErpPoType Not used for export in ERP. N/A N/A

Invoice/LineItem/MaterialGroup This column represents the material group of the
purchase order line item material. If available,
it can be mapped simply to pass this data to a
downstream ERP for a paired line item.

N/A N/A

Invoice/LineItem/Plant Plant ID. This is lifted from the purchase order
line item with which an invoice line is paired.

N/A N/A

Invoice/LineItem/
PoLineNumber

The purchase order line item number. It
is populated only if line pairing has been
successful for this item.

MAD-LINE-
NBRr0

N/A

Invoice/LineItem/Puom The order unit of measure and it is populated
with the purchase order line item order unit
measure if the line item has been paired.

N/A N/A

Invoice/LineItem/QtyPuom The quantity in the order price unit of meausre.
This value is calculated during line pairing if
UOM does not correspont to PUOM.

N/A N/A

Invoice/LineItem/
TaxableAmount

Taxable amount APD-
TAXABLE-
AMT

Only mapped
on non-po
Invoices

Invoice/LineItem/TaxCode The invoice line item tax code, and it is
populated using the tax determination procedure
if a line item is paired.

APD-TAX-
CODE

Only mapped
on non-po
Invoices

Invoice/LineItem/Activity Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A Mapped in
GLSegments

Invoice/LineItem/BusinessArea Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A Mapped in
GLSegments

Invoice/LineItem/CostCenter Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A Mapped in
GLSegments
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Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem/DbCrIndicator The subsequent debit or credit indicator that
indicates is the line item is a subsequent debit of
a credit line item. If this value is set to X and the
document type is INVOICE, then the line item is
treated as a subsequent debit, the amount only
and not the quantity. If the value is set to X and
the document type is CREDIT then the line item
is treated as a subsequent credit. If the value
is blank the line item is treated as a regular line
item.

N/A N/A

Invoice/LineItem/InternalOrder Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/Network Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/ProfitCenter Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/SalesOrder Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/
SalesOrderItem

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/TaxJurCode The invoice line tax jurisdiction code. It
represents the downstream ERP system ID for
the tax office where taxes are paid for this line
item. This is used in countries that have tax
jurisdictions for their sales tax. It is populated
only if the line item is paired.

N/A N/A

Invoice/LineItem/WbsElement Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/GlAccount GL account string specified in APA coding
activity.

N/A N/A

52



Kofax AP Agility Administrator's Guide

Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem/GlSegment The value of one GL segment in GL account.
This tag may repeat for the invoice line. The
number of the segments should be equal to the
number of segments specified for the account
(in GlAccount tag). Each GlSegment tag should
have two attributes: <

1. · segmentNumber - the number of the
segment in the account structure (as
specified in APA configuration for the
segment structure

1. · name - the segment name as specified
for this segment in GL structure CSV

Example: 
<GlAccount>01-000-1100-0000-000<GlAccount>
<GlSegment segmentNumber="1"
name="Organization">01<GlSegment>
<GlSegment segmentNumber="2"
name="Department">000<GlSegment>
<GlSEgment segmentNumber="3"
name="Account">1100<GlSegment>
<GlSegment segmentNumber="4"
name="SubAccount">0000<GlSegment>
<GlSegment segmentNumber="5"
name="Project">000<GlSegment>

NON-PO/
Credit
Invoices :
APD-DIST-
COMPANYr0
APD-DIS-
ACCT-UNITr0
APD-DIS-
ACCOUNTr0
APD-DIS-
SUB-ACCTr0
ADD-ON-
COST: API-
COMPANY
MISC-ACCT-
UNITr0 MISC-
ACCOUNTr0
MISC-SUB-
ACCTr0 PO-
Invoices: N/A

Based on
the line type
different logic
is used to map
fields

Invoice/LineItem/
ConditionCount

Not used for export in ERP. SAP only - refers to
planned conditions

N/A N/A

Invoice/LineItem/
ConditionStepNo

Not used for export in ERP. SAP only - refers to
planned conditions

N/A N/A

Invoice/LineItem/ConditionType Not used for export in ERP. SAP only - refers to
planned conditions

N/A N/A

Invoice/LineItem/FreightVendor Not used for export in ERP. SAP only - also
related to planned conditions

N/A N/A

Invoice/LineItem/GrDocItem The receipt line item number. It is populated only
if 3-way line pairing has been successful for this
item.

N/A N/A

Invoice/LineItem/GrDocNo The receipt number, and is populated only if 3-
way line pairing is successful for this item.

N/A N/A

Invoice/LineItem/GrDocYear Not used for export in ERP. N/A N/A

Invoice/LineItem/SheetItem Not used for export in ERP. N/A N/A

Invoice/LineItem/SheetNo Not used for export in ERP. N/A N/A

Invoice/LineItem/
IpaBusinessUnit

PeopleSoft business unit, copied over from PO
line. APA doesn't seem to support that in its data
model?

N/A N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem/IpaLineType Invoice line item type populated by IPA (see the
Line Type field above). This is lifted from the
purchase order line item to which an invoice line
is paired.

N/A N/A

Agnostic ERP integration
For Agnostic ERP, create an ERP connection and give it a unique name, assign it to the organization, and
configure the ERP connector service in web.config. Follow these steps:

1. Create the ERP connection as shown in Create ERP connection. Complete the information in the
fields and give the connection a unique name. In the Connection Type field, select ERP Agnostic.

Note The Start Data Load From setting is ignored, but a value must be provided.

2. Set up the organization to use the ERP connection as shown in Organization settings.
3. Locate the web.config file in the web server folder used by the ErpConnector service and open it with

a text editor.
4. Modify web.config as follows:

a. Under <configuration><erpConnector><plugins>, add a <plugin> element for the Agnostic ERP
connection:
<plugin type="Files">
  <class>Kofax.ApAgility.ErpConnector.Files.Plugin,
 Kofax.ApAgility.ErpConnector, Version=1.0.0.0, Culture=neutral,
 PublicKeyToken=31bf3856ad”64e35”</class>
</plugin>

b. Under <configuration><erpConnector><connections>, add <connection> and subelements to
define the connection:
<connection name="AgnosticERPName" type="Files">
   <add name ="input_path" value="C:\Agnostic\Import" />
   <add name ="output_path" value="C:\Agnostic\Export" />
   <add name ="apply_xslt" value="false" />
   <add name ="xslt_path" value="C:\Agnostic\example.xslt" />
</connection>

For <connection>, the name attribute (must match the name of the ERP connection defined
in defined in step 1. In this example, AgnosticERPName is the name of the connection, and it
should be changed to the name of the one you created.
The type attribute in <connection> should match the type attribute in <plugin>.
For each of the <add> elements, provide the following values for these attributes. The paths
specified must be accessible to Kofax AP Agility.
• input_path: Enter the path to the folder containing the master data files used for import.
• output_path: Enter the path where the invoice data will be exported.
• apply_xslt: If you are using an XSLT file to transform the data, set to true. If you do not want

to transform the data, set to false.
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• xslt_path: Enter the path and file name of the XSLT file used to transform the data. A value
must be provided. If apply_xslt is set to false, this value is ignored.

c. Save the file.

Invoice export

Exported invoice XML file structure
Kofax AP Agility automatically generates the name of the exported XML file with the invoice image stored
in base64 format. The name of XML file consists of the Invoice number in the Kofax AP Agility database
and the export timestamp separated by the underscore (_) symbol.

For the ERP agnostic connection, Kofax AP Agility generates the name of the file with an invoice image
in the same manner. Kofax AP Agility exports the invoice image in the same format as it is stored in Kofax
Invoice Processing Agility. If a file with the same name already exists in the output folder, a new unique
name is given to the file.

Kofax AP Agility exports organization fields that are set visible on the user interface. In addition to the
visible fields, Kofax AP Agility always exports line pairing fields imported from Invoice Processing Agility
and ECM document ID.

Kofax AP Agility always export the following Invoice Header fields.

Field Name Description

EcmDocumentId ECM Document ID

DocumentLink Document link

ErpPoType JD Edwards PO extension if the JD Edwards PO Number
Validation option is enabled in Kofax Invoice Processing
Agility

ScanDate Invoice Processing Agility scan date

SubTotal Sum of all NetAmount fields

Urn Storage field URN (Unique resource number)

IpaInvalidReasonCode Kofax Invoice Processing Agility invalid reason code

IpaInvalidReasonRule Kofax Invoice Processing Agility invalid reason rule

IpaOrganizationName Kofax Invoice Processing Agility organization name

IpaOrganizationId Kofax Invoice Processing Agility organization ID

PaymentComments Payment comments

PaymentMethod Payment methods that indicate a bank transfer and the
requirement for a bank account

ImageExtension Format of the invoice image, such as .pdf or .tiff

ImageBase64 Invoice image encoded in base64 format

PaymentComments and EcmDocumentId fields are defined in Kofax AP Agility. All other fields are
imported from Kofax Invoice Processing Agility.
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The following table lists the fields used for line items. Kofax AP Agility exports each GL segment
separately using the GlSegment tag name. An invoice line may contain multiple GlSegment tags, which
each one containing information about the GL segment number, name and value. The following is an
example:
<GlSegment segmentNumber="1" name="Segment1">002</GlSegment>

Field Name Description

LineNumber ERP PO line number ID.

ChargeCode Invoice line item charge code. The value is taken from the purchase order
line item to which an invoice line is paired.

ChargeCodeId Invoice line item charge code ID. The value is taken from the purchase
order line item to which an invoice line is paired.

CompanyCode Company code that corresponds to a line item. The value is taken from the
purchase order when an invoice line is paired.

ErpPoType JD Edwards PO extension if the JD Edwards PO Number Validation option
is enabled in Kofax Invoice Processing Agility

MaterialGroup The value is taken from the purchase order line item to which an invoice
line is paired. If available, it can be mapped to pass this data to a
downstream system for a paired line item. It is also used in the automatic
tax determination procedure if the selection of the correct tax code is
driven by the material group of the item.

Plant Plant ID. The value is taken from the purchase order line item with which
an invoice line is paired. The plant is a code set in the client ERP system
that represents the physical location where the purchase order line
goods are delivered, or where a service is performed. For example, it can
represent a warehouse or an office building.

PoLineNumber The purchase order line item number. It is populated only if line pairing is
successful for this item.

Puom This column represents the order price unit of measure. This is the unit of
measure associated with the unit price for the purchase order line item. It
may differ from the regular unit of measure that is associated with the order
quantity on the purchase order line.

QtyPuom The invoice line item quantity expressed in the order price unit of measure.

TaxableAmount Taxable amount

TaxCode For countries that do not use tax jurisdictions, the tax code informs the
ERP system how to handle tax for line items. Some countries that do
not use tax jurisdiction because tax rates are set by the government at a
national level, such as within the European Union. The tax code uses the
percentage rate of tax that is charged, as well as describing if an item is
a service, it is tax-exempt, or it is zero-rated because it is a cross-border
transaction. Under these circumstances, tax jurisdiction is not used. For
countries that do not use tax jurisdictions, the tax code informs the ERP
system whether the item is subject to tax or not. Some countries that do
use tax jurisdictions have tax rates that are set at a local level such as
in the United States, Canada, India, and Brazil. The accompanying tax
jurisdiction code, which is the identification umber of a specific tax office,
represents the actual percentage rate information. These columns are only
mapped if the automatic tax determination feature is used.
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Field Name Description

Activity GL Data: The project activity.

BusinessArea GL Data: The business area.

CostCenter GL Data: The cost center that is used for miscellaneous charge general
ledger entries.

DbCrIndicator GL Data: The debit/credit indicator.

InternalOrder GL Data: The internal order number.

Network GL Data: The project network.

ProfitCenter GL Data: The profit center that is used for miscellaneous charge general
ledger entries.

SalesOrder GL Data: The sales order document number.

SalesOrderItem GL Data: The sales order document item number.

TaxJurCode Tax jurisdiction code. See description for TaxCode.

WbsElem GL Data: The work breakdown structure element.

GlAccount General ledger account entry

GlSegment General ledger account segment

ConditionCount SAP condition count

ConditionStepNo SAP condition step number

ConditionType SAP condition type

FreightVendor Freight vendor ID

GrDocItem Goods receipt document item number

GrDocNo Goods receipt document number

GRDocYear Goods receipt document year.

SheetItem SAP Service entry sheet item

SheetNo SAP Service entry sheet item

IpaBusinessUnit PeopleSoft PO extension if the PeopleSoft PO Number Validation option is
enabled in Kofax Invoice Processing Agility

IpaLineType Kofax Invoice Processing Agility line type

For example, the structure of the XML file may look as follows:

<?xml version="1.0" encoding="utf-8"?>
<Invoice>
  <BusinessUnitID>204</BusinessUnitID>
  <Currency>USD</Currency>
  <Discount>0</Discount>
  <DiscountDueDate></DiscountDueDate>
  <DocumentType>INVOICE</DocumentType>
  <DueDate>7/3/2017 12:00:00 AM</DueDate>
  <Freight>90</Freight>
  <InvalidReason></InvalidReason>
  <InvoiceDate>7/3/2017 12:00:00 AM</InvoiceDate>
  <InvoiceNumber>GECD204NP504</InvoiceNumber>
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  <InvoiceType>NON-PO</InvoiceType>
  <AmtMiscellaneous>0</AmtMiscellaneous>
  <NetAmount1>752.97</NetAmount1>
  <PoNumber></PoNumber>
  <PoType></PoType>
  <TaxAmount1>47.06</TaxAmount1>
  <InvoiceAmount>890.03</InvoiceAmount>
  <VendorCity>New York</VendorCity>
  <VendorId>GEC0001</VendorId>
  <VendorName1>GE Capital</VendorName1>
  <VendorState>NY</VendorState>
  <VendorStreet1>Abbey Road 69</VendorStreet1>
  <VendorZip>Zip1</VendorZip>
  <EcmDocumentId />
  <DocumentLink>d3351e6b-d44c-4b39-9e34-a8e80134000c</DocumentLink>
  <ErpPoType></ErpPoType>
  <ScanDate>5/22/2018 12:00:00 AM</ScanDate>
  <SubTotal>752.97</SubTotal>
  <Urn>b86a703b-58f9-47da-83cb-a8e80133d466</Urn>
  <IpaInvalidReasonCode></IpaInvalidReasonCode>
  <IpaInvalidReasonRule></IpaInvalidReasonRule>
  <IpaOrganizationName />
  <IpaOrganizationId />
  <PaymentComments />
  <PaymentMethod></PaymentMethod>
  <ImageExtension>.pdf</ImageExtension>
  <ImageBase64>
    (embedded image string>
  <LineItem>
    <Category></Category>
    <Description></Description>
    <Discount>0</Discount>
    <LineType>Item</LineType>
    <MaterialNumber></MaterialNumber>
    <PoNumber></PoNumber>
    <Quantity>1</Quantity>
    <Total>890.03</Total>
    <UnitPrice>890.03</UnitPrice>
    <UnitOfMeasure></UnitOfMeasure>
    <UnitOfQuantity>1</UnitOfQuantity>
    <TaxAmount>0</TaxAmount>
    <TaxRate>0</TaxRate>
 <LineNumber>1</LineNumber>
    <ChargeCode />
    <ChargeCodeId />
    <CompanyCode />
    <ErpPoType />
    <MaterialGroup />
    <Plant />
    <PoLineNumber />
    <Puom />
    <QtyPuom></QtyPuom>
    <TaxableAmount></TaxableAmount>
    <TaxCode></TaxCode>
    <Activity />
    <BusinessArea />
    <CostCenter />
    <DbCrIndicator />
    <InternalOrder />
    <Network />
    <ProfitCenter />
    <SalesOrder />
    <SalesOrderItem />
    <TaxJurCode></TaxJurCode>
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    <WbsElem />
    <GlAccount>002-005</GlAccount>
    <GlSegment segmentNumber="1" name="Segment1">002</GlSegment>
    <GlSegment segmentNumber="2" name="Segment2">005</GlSegment>
    <ConditionCount />
    <ConditionStepNo />
    <ConditionType />
    <FreightVendor />
    <GrDocItem></GrDocItem>
    <GrDocNo></GrDocNo>
    <GrDocYear />
    <SheetItem />
    <SheetNo />
    <IpaBusinessUnit />
    <IpaLineType />
  </LineItem>
</Invoice>

XSLT file for conversion from XML to CSV
For the ERP agnostic plugin, Kofax AP Agility provides the XSLT file used to convert the exported invoice
from XML to CSV format.

For each ERP connection, Kofax AP Agility Administrator configures the XSLT file to transform the XML
file of the exported invoice with the help of the ERP Connections form. Kofax AP Agility users can provide
their own XSLT script for the conversion.

The XSLT sample script shows how to export invoices to CSV format:

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
<xsl:template match="/">
    <xsl:text>AmtMiscellaneous,BusinessUnitID,Currency,DiscountDueDate,DueDate,
EmployeeName,Freight,InvoiceDate,InvoiceNumber,InvoiceType,LineItems,NetAmount0,
NetAmount1,OrganizationName,PoNumber,TaxAmount1,TaxRate1,InvoiceAmount,VendorName1,
EcmDocumentId,DocumentLink,ErpPoType,ScanDate,SubTotal,Urn,IpaInvalidReasonCode,
IpaInvalidReasonRule,IpaBusinessUnitName,IpaOrganizationName,IpaOrganizationId,
IpaVendorIndexId</xsl:text>
    <xsl:text>&#10;</xsl:text>   
 <xsl:value-of select="Invoice/AmtMiscellaneous"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/BusinessUnitID"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/Currency"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/DiscountDueDate"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/DueDate"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/EmployeeNamev"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/Freight"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/InvoiceDate"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/InvoiceNumber"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/InvoiceType"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/LineItems"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/NetAmount0"/>
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 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/NetAmount1"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/OrganizationName"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/PoNumber"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/TaxAmount1"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/TaxRate1"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/InvoiceAmount"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/VendorName1"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/EcmDocumentId"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/DocumentLink"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/ErpPoType"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/ScanDate"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/SubTotal"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/Urn"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/IpaInvalidReasonCode"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/IpaInvalidReasonRule"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/IpaBusinessUnitName"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/IpaOrganizationName"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/IpaOrganizationId"/>
 <xsl:text>,</xsl:text>
 <xsl:value-of select="Invoice/IpaVendorIndexId"/> 
 <xsl:text>&#10;</xsl:text> 
 <xsl:text>LineNumber,LineType,OriginalLineNumber,Quantity,Total,UnitPrice,ChargeCode,
ChargeCodeId,CompanyCode,ErpPoType,MaterialGroup,Plant,PoLineNumber,Puom,QtyPuom,
TaxableAmount,TaxCode,Activity,BusinessArea,CostCenter,DbCrIndicator,InternalOrder,
 Network,ProfitCenter,SalesOrder,SalesOrderItem,TaxJurCode,WbsElem,GlAccount,
ConditionCount,ConditionStepNo,ConditionType,FreightVendor,GrDocItem,GrDocNo,GrDocYear,
SheetItem,SheetNo,IpaBusinessUnit,IpaLineType</xsl:text>
 <xsl:text>&#10;</xsl:text>
 <xsl:for-each select="Invoice/LineItem"> 
  <xsl:value-of select="LineNumber"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="LineType"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="OriginalLineNumber"/>
  <xsl:value-of select="Quantity"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="Total"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="UnitPrice"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="ChargeCode"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="ChargeCodeId"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="CompanyCode"/>
  <xsl:text>,</xsl:text>
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  <xsl:value-of select="ErpPoType"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="MaterialGroup"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="Plant"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="PoLineNumber"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="Puom"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="QtyPuom"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="TaxableAmount"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="TaxCode"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="Activity"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="BusinessArea"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="CostCenter"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="DbCrIndicator"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="InternalOrder"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="Network"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="ProfitCenter"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="SalesOrder"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="SalesOrderItem"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="TaxJurCode"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="WbsElem"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="GlAccount"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="ConditionCount"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="ConditionStepNo"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="ConditionType"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="FreightVendor"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="GrDocItem"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="GrDocNo"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="GrDocYear"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="SheetItem"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="SheetNo"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="IpaBusinessUnit"/>
  <xsl:text>,</xsl:text>
  <xsl:value-of select="IpaLineType"/>
  <xsl:text>&#10;</xsl:text>
 </xsl:for-each>
</xsl:template>
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</xsl:stylesheet>

ERP master data import
The ERP master data in the Kofax AP Agility database must be updated regularly. For the Agnostic ERP,
data is imported from CSV files. For other connections, data is imported from the ERP application.

For the Agnostic ERP, you can configure a path to the file system folder where the data in CSV files must
be taken from. The files must be in the appropriate CSV format for the data being imported.

To import the ERP master data, use the AP Data Import job. Kofax AP Agility Administrator sets up the
schedule for the job or starts the job manually. One job imports data for all organizations.

Kofax AP Agility makes records about the status of the import jobs in these Kofax AP Agility database
tables:
• ERP_CONNECTOR_SERVICE_CALL_STATUS: Contains the status of each ERP Connector call.
• ERP_IMPORT_JOB_STATUS: Contains the status of loading data as it is prepared by the ERP

Connector to the Kofax AP Agility database.

Use these records for troubleshooting purposes if the import fails or not all data was loaded.

The ERP master data includes the following types of data with the corresponding Kofax AP Agility
database tables:
• ERP invoices: ERP_INVOICE
• Payment terms: PAYMENT_TERM
• Payment terms details: PAYMENT_TERM_DETAIL
• Vendors: VENDOR_MASTER_DATA
• PO headers: PO_HEADER
• PO lines: PO_LINES
• GL Segments: GL_SEGMENTS
• Plants: PLANTS
• Receipt lines: RECEIPT_LINES

The following types of data are shared with the corresponding Kofax Invoice Processing Agility database
tables:
• Tax Codes: TaxCode
• Miscellaneous Charge: MiscChargesAccount
• Unit of Measure Conversions: BRWUOMConversions
• Employee: BRWEmployeeMaster

The data for all ERP master data types is located in the corresponding CSV files. Data types and formats
are as follows:
• Number: Standard number numeric format
• Integer: Standard integer number format
• Double: Double number format with floating decimal
• String: Commas in the text must be in quotation marks
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• Datetime: yyyy-mm-dd HH:MM:SS
• Bit: 0 or 1

CSV exchange format
In CSV format, place the fields in the order specified in this section. This format must contain a header,
and fields must be separated by comma.

ERP invoices CSV format
Table name: ERP_INVOICE

File name (for Agnostic ERP): erp_invoices.csv

Field Index Type Description

1 String Invoice ID in ERP

2 String Business unit ID in ERP

3 String Invoice number

4 Datetime Invoice date

5 String Invoice type:
• PO (for single PO invoices)
• NON-PO
• Credit Memo Invoice

6 Number Invoice amount

7 String PO Number (or Purchase Order
Number)

8 Datetime Payment date

9 Datetime Canceled date

10 String Invoice payment status (PAID or
UNPAID)

11 String Vendor Name

12 String Vendor site code

13 String Vendor site ID

14 String ERP vendor ID

For example, the contents of the erp_invoices.csv file may look as follows:

ERP_INVOICE_ID, ERP_BUSINESS_UNIT_ID, INVOICE_NUMBER, INVOICE_DATE, INVOICE_TYPE,
 INVOICE_AMOUNT, PO_NUMBER, PAYMENT_DATE, CANCELLED_DATE, INVOICE_STATUS, VENDOR_NAME1,
 VENDOR_SITE_CODE, VENDOR_SITE_ID, ERP_VENDOR_ID
214303,204,nd03np_KTM_05/31/2017,2017-05-31 00:00:00,Non-PO Invoice,1000,,,,UNPAID,GE
 Capital,BOSTON,289,93
214304,204,nd04np_KTM_05/31/2017,2017-05-31 00:00:00,Non-PO Invoice,1000,,,,UNPAID,GE
 Capital,BOSTON,289,94
214302,204,nd02np_KTM_05/31/2017,2017-05-31 00:00:00,Non-PO Invoice,1000,,,,UNPAID,GE
 Capital,BOSTON,289,95
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Payment terms CSV format
Table name: PAYMENT_TERM

File name (for Agnostic ERP): payment_terms.csv

Field Index Type Description

1 String Payment term ID in ERP

2 String Business unit ID in ERP

3 String Payment term name

4 String Payment term description

For example, the contents of the payment_term.csv file may look as follows:

ERP_TERM_ID, ERP_BUSINESS_UNIT_ID, TERM_NAME, TERM_DESCRIPTION
10000,204,Prepayment Immediate,Seeded immediate terms for prepayments - do not update
10001,204,Immediate,Scheduled for payment immediately

Payment terms details CSV format
Table name: PAYMENT_TERM_DETAIL

File name (for Agnostic ERP): payment_term_details.csv

Field Index Type Description

1 String Payment term detail ID in ERP

2 String Business unit ID in ERP

3 Number Payment sequence number

4 Number Percentage of invoice amount that
must be paid before the invoice due
date

5 Number Amount that must be paid before the
invoice due date. One of the fields
DUE_PERCENT or DUE_AMOUNT
must be left blank

6 Number Days left before the invoice due date

7 Number Day of the month in the invoice due
date

8 Number Months left for the invoice to be paid

9 Number Percentage of the discount

10 Number Days left before the discount due
date

11 Number Day of the month before the discount
due date

12 Number Months before the discount due date
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Vendors CSV format
Table name: VENDOR_MASTER_DATA

File name (for Agnostic ERP): vendors.csv

Field Index Type Description

1 String The unique vendor ID from the
extracted data. Each row must have
a unique reference. This is not the
unique vendor ID from the ERP
system if a site ID is also used.

2 String Business unit ID in the ERP
(company code).

3 String Default ERP payment terms ID for
the vendor. It should match the
payment terms in Payment Terms
CSV.

4 String Description.

5 String Vendor name.

6 String Vendor site ID. It should be empty if
the ERP does not support the vendor
sites.

7 String Vendor site code. It should be empty
if the ERP does not support the
vendor sites.

8 String Vendor street address line 1.

9 String Vendor street address line 2.

10 String Vendor city.

11 String Vendor zip code or postal code.

12 String Vendor state. For U.S. addresses,
the state code is expected here, such
as CA = California, VA = Virginia.

13 String Vendor country. This is a two
character ISO-code for the country,
such as US = United States of
America, DE = Germany, GB =
United Kingdom.

14 String Vendor VAT code.
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Field Index Type Description

15 String Vendor VAT registration number.
If the vendor is registered for VAT
in more than one country, then
multiple VAT registration numbers
are provided in the form of a comma-
separated list and the entire column
value should be quoted to preserve
CSV format.

16 String Tax number.

17 String Bank code. This is the U.S.
equivalent of a routing number.

18 String Bank account number.

19 String Email.

20 String URL.

21 String Vendor telephone number.

22 String Fax.

23 String Contact name.

24 Bit Is active.

25 Bit Is enabled.

26 String Term date basis:
• Invoice.
• Goods received.
• Current.
• Invoice received.

27 String Vendor Post Office (PO) box number.

28 String ZIP or postal code associated with
the vendor Post Office (PO) box.

29 Bit The boolean indicator that denotes
whether the vendor belongs to an EU
member state country.

30 String Vendor currency.

31 String Vendor tax ID 1.

32 String Vendor tax ID 2.

33 String ID of the tax office where the vendor
is based.
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Field Index Type Description

34 String Vendor invoice type. This is set to
a value that denotes either PO-
supplying vendor or vendor that
submit invoices that legitimately do
not reference the purchase order.
The value should be:
• FI: If the vendor can send non-PO

invoices.
• MM: Vendor is able to send only

PO invoices.

35 String The comma-separated list of
payment method codes appropriate
for the vendor. If more than one code
is specified then entire column value
to be quoted to preserve CSV format.

36 String Leave this value empty.

37 String The comma-separated list of
company codes that are valid for
the vendor. If more than one code is
specified then entire column value to
be quoted to preserve CSV format.

38 Bit Indicates whether the vendor is a
utility vendor

39 String Vendor POR subscriber number used
only for Switzerland.

40 String External site ID.

41 String ERP system vendor account group.

42 String Party that receives payment for an
invoice.

43 String Leave this value empty.

44 String The vendor SIRET ID. This ID
code used in France that uniquely
identifies a single vendor at a single
address. It is often found on French
invoices.

45 String The unique vendor identifier code,
such as a Chinese tax number.

46 String Indicates whether a vendor is or is
not an Intercompany vendor.

47 String Vendor bank account code as
specified in ERP.

PO headers CSV format
Table name: PO_HEADER
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File name (for Agnostic ERP): po_headers.csv

Field Index Type Description

1 String PO header ID in ERP

2 String Business unit ID in ERP

3 String PO number

4 String PO type:
• MATERIAL
• SERVICE

5 String Vendor ID in ERP

6 String Vendor name

7 String Vendor site ID

8 String Vendor site code

9 String PO Status

10 Bit Is Active

PO lines CSV format
Table name: PO_LINES

File name (for Agnostic ERP): po_lines.csv

Field Index Type Description

1 String PO line ID in ERP

2 String Business unit ID in ERP

3 String PO header ID in ERP

4 String PO number

5 Number Line number

6 String Material number

7 String Material group

8 String Description

9 Number PO Quantity

10 Number Unit price

11 Number PO total

12 String Tax code

13 String Tax jurisdiction code

14 String Unit of measure

15 Number Price unit

16 String PUOM (Order price unit of measure)
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Field Index Type Description

17 Number Total quantity delivered

18 Number Total value delivered

19 Number Total quantity invoiced

20 Number Total value invoiced

21 String Item category or line item type

22 String Plant (The location code for the ship-
to address where the goods were
delivered, or where a service was
performed)

23 String Charge code

24 String Charge code ID

25 String ERP PO type (for JD Edwards PO)

26 String ERS flag

27 Bit Receipt required

GL segments CSV format
Table name: GL_SEGMENTS

File name (for Agnostic ERP): gl_segments.csv

Field Index Type Description

1 String GL Segment ID in ERP

2 String Business unit ID in ERP

3 Integer GL Segment Number

4 String GL Segment Value

5 String Description

6 String GL Segment Name

Plants CSV format
Table name: PLANTS

File name (for Agnostic ERP): plants.csv

Field Index Type Description

1 String Plant ID. It must be unique in CSV. It
matches Plant field specified for PO
lines. It is exported as the invoice line
Plant field.
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Field Index Type Description

2 String Organization ID the plant belongs to.
If an organization ID is not provided,
the plant is created and linked to the
same organization to which the ERP
Connection belongs.

3 String Two character ISO country code
for the plant. Entries with empty
country code are skipped in the
import process.

4 String State where the plant is located.
For the United States, use the two-
character state code such as CA for
California.

Receipt Lines data format
Table name: RECEIPT_LINES

File name (for Agnostic ERP): receipt_lines.csv

Field Index Type Description

1 String Business unit ID in ERP (company
code).

2 String PO number, which is used during line
pairing to match the receipt line to the
number of PO. (See PO lines CSV
format.)

3 String ERP PO line number. This is an
ERP-specific line ID in the PO, such
as the line number. It must be unique
among lines in the PO. It is used
during line pairing to match the
receipt line to the number of PO line.
(See PO lines CSV format.)

4 String ERP receipt ID. It is used by Invoice
Processing Agility as the receipt
number (DOC_NO field) during line
pairing. For the line paired invoice
lines, it is exported as GRDocNo tag.

5 String ERP receipt item number. It is used
by Invoice Processing Agility as the
receipt item (DOC_ITEM field) during
line pairing. For paired invoice lines,
it is exported as the GRDocItem tag.

6 String Delivery document number.

7 Double Quantity.

8 Double Unit price.
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Field Index Type Description

9 Double Total amount.

10 Double Quantity invoiced.

11 Double Total invoiced.

12 String Receipt year.

Employee format
Table name: BRWEmployeeMaster

File name (for Agnostic ERP): employee.csv

Field Index Type Description

1 String Index ID of the employee record. This
value is required.

2 Integer ID of the partition for the employee.
This value is required.

3 String ID of the employee. This field is
required.

4 String Employee name.

5 String First line of the employee's address.

6 String Second line of the employee's
address.

7 String Employee's city.

8 String Employee's ZIP code.

9 String Employee's state.

10 String Employee's country code.

11 String Employee's telephone number.

12 String Employee's tax ID 1.

13 String Employee's tax ID 2.

Miscellaneous Charge format
Table name: MiscChargesAccount

File name (for Agnostic ERP): misc_charge.csv

Field Index Type Description

1 Integer PO partition. This field is required.

2 String Company code. This field is required.

3 String Category of the charge. This field is
required.
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Field Index Type Description

4 String Plant.

5 String Line type.

6 String GL account number.

7 String Cost center.

8 String Profit center.

9 String Tax code.

Tax code format
Table name: TaxCode

File name (for Agnostic ERP): taxcode.csv

Field Index Type Description

1 Integer Partition ID.

2 String Vendor ID.

3 String Two-character country code. This
value is required.

4 String Two-character code of the country
where the item was shipped to. This
value is required.

5 String Two-character code of the country
where the item was shipped from.
This value is required.

6 String If this is a service. Enter either Y or
N.

7 String Material number.

8 String Material group.

9 Number Tax percentage. This value is
required.

10 String Tax code.

Unit of Measure Conversion format
Table name: BRWUOMConversions

File name (for Agnostic ERP): uom_conversion.csv

Field Index Type Description

1 Integer PO partition. This field is required.

2 String Material number. This field is
required.
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Field Index Type Description

3 String Base unit of measure. This field is
required.

4 String Numerator for the unit of measure.
This field is required.

5 String Denominator for the unit of measure.
This field is required.

6 String External unit of measure. This field is
required.

Configure ERP import job schedule
To configure the optimal schedule, consider the amount of the ERP master data. If you have a large
amount of the ERP master data and you set the import job schedule to run too often, performance issues
may occur.

To set up a job schedule for the import of the ERP master data to the Kofax AP Agility database:
1. Log in to Kofax TotalAgility Designer as Kofax TotalAgility Administrator.
2. Click System Settings and select Job Schedules.
3. Click the plus sign next to Job Schedules to create a new schedule or modify the schedule from the

list.
4. Fill in the Job Schedule form according to your requirements.

a. Specify a name for Schedule Job.

b. Filter Process Explorer by the AP Agility category and drag and drop the AP Data Import job
to the Process field.

c. Specify Frequency.
We recommend that you set up the import job schedule to run once a day. In case of performance
issues, you may want to set up the execution of the import job in an off-time period.

5. Click OK to save the import job schedule.

ERP import job status history
Kofax AP Agility keeps the following information about the executed import jobs in the
ERP_IMPORT_JOB_STATUS table of the Kofax AP Agility database:
• Job status ID
• Kofax AP Agility job ID
• Import datetime
• Import status
• Error messages
• Number of ERP invoices imported to the Kofax AP Agility database
• Number of payment terms imported
• Number of payment terms details imported
• Number of PO headers imported
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• Number of PO lines imported
• Number of receipt lines imported
• Number of vendors imported
• Number of GL segments imported
• Number of plants imported
• Number of IPA employees imported
• Number of IPA UOM conversions imported
• Number of IPA tax codes imported
• Number of IPA miscellaneous charges imported
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Kofax AP Agility document workflow

This chapter describes processing of PO and Non-PO invoices and credit memos through the Kofax AP
Agility workflow.

The Kofax AP Agility workflow starts with the invoice import from Kofax Invoice Processing Agility to Kofax
AP Agility and ends after the invoice is exported to the ERP system or when the invoice is canceled.

Information about using workflow features in the Kofax AP Agility app in TotalAgility Workspace is also
available in the Kofax AP Agility help.

PO invoice and credit memo workflow
After a PO invoice or a credit memo is successfully validated, it moves directly to the Export queue.

Non-PO invoice workflow
After a Non-PO invoice is successfully validated, Kofax AP Agility verifies if the invoice requires GL coding
or approval.
• If the invoice is not fully distributed, it is routed to the GL Coding queue.
• If the invoice is fully distributed, Kofax AP Agility checks the invoice Total Amount field. If the value is

below or equal to the automatic approval level for the invoice business unit, the invoice moves to the
Export queue. Otherwise, it moves to the Approval queue.

Invoice activity form
On the Kofax AP Agility Work Queue form, the following activities are available:
• Exception
• GL Coding
• Approval
• Comment Request
• Hold: Exception (Hold), Invoice Coding (Hold), Approval (Hold)
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Controls Description

Invoice image view Displays the invoice image.
You can zoom the image.
To open the invoice image in a new window, click Undock .

Status tab Provides a short description of your further actions.
Also, displays a list of errors if an invoice is in the Exception state.

Header tab Displays the controls for the invoice header fields. You can edit all, some, or
none controls depending on the type of the form.
This tab displays only the fields that you selected as active for the invoice
Kofax AP Agility organization.

Lines tab Displays a table with invoice lines. You can perform the following operations:
• Change field values for the lines
• Specify GL code for the lines
• Add lines
• Modify lines
• Delete lines
• Enter receipt numbers and lines

This tab displays only the fields that you selected as active for the invoice
Kofax AP Agility organization.

History tab Displays the invoice history summary.

Action bar The Action bar contains controls that you can use to complete or cancel the
Kofax TotalAgility activity, perform the invoice reassignment, increase priority.
Select routing options, such as invoice reassignment, comment request, hold
or reject an invoice.
The Action bar contains the following buttons:
• Discard Changes
• Save and Retain Ownership
• Increase Priority
• Email Document
• Submit

Header tab
The Header tab displays all the header level fields of the active invoice for the current organization.

Kofax AP Agility displays only groups that have active fields.

The Business Info group contains the information about the business unit of the invoice. You can select
the business unit name from the list to change the business unit for the invoice. Changing the business
unit name changes the business unit ID. The business unit ID field is always read-only.

The Vendor Info group shows all vendor-related fields. All the vendor fields are read-only. However, if
you need to change the invoice vendor, click Vendor Search. If you change the vendor, all vendor-related
fields on the Vendor Info group are repopulated with values for the selected vendor.
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On the Invoice Header group, you can view the invoice header information, such as Document Type,
Invoice Number, Invoice Amount, Invoice Type and Date, Invoice and Discount Due Date. You can select
the currency from the list to change the invoice currency. Changing the invoice currency does not change
the invoice amount.

The Invoice Amounts group displays the information about Net Amount, Tax Rate, and Tax Amount.

The Invoice Footer group includes the bank account details and payments information.

Lines tab
Use the Lines tab to review the invoice lines and perform the following operations:
• Change field values for the lines
• Specify GL code for the lines
• Add lines
• Modify lines
• Delete lines
• Enter receipt numbers and lines

Kofax AP Agility displays only the line fields that are active in the organization configuration. For PO
invoices, it includes the receipt number and receipt line fields.

You can select one or multiple lines and change their GL code within a single operation. To change other
fields, select an individual line.

If you plan to split lines to code them separately, save the information about the original invoice
line number before you specify a value of the Original Line Number for lines. Originally, the value
corresponds to Line Number.

To code the invoice, click Choose GL Code to open the Choose GL Code form. Alternatively, enter the
GL code in the corresponding area. Use the drop-down list with GL codes that were used recently or
specify GL codes manually.

History tab
The History tab displays the table with all operations performed for an invoice in Kofax AP Agility with the
information about:
• Activity Name
• Result
• User
• Created Date
• Note

Save and Retain Ownership
If you need to save changes in an invoice without submitting it for further processing, click Save and
Retain Ownership.
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The changes you made are saved. If you exit from the Invoice activity form, the invoice remains in your
work queue.

Discard Changes
If you want to discard all changes made for the current operation and interrupt the operation, click the
Discard Changes button. However, the Discard Changes option does not discard all changes.

Discarding changes is similar to the Kofax TotalAgility cancel activity operation. After you discard changes,
the invoice remains in the current queue and its assignment does not change.

Increase Priority
To increase the priority of an invoice, use the Increase Priority action. The Increase Priority button is
available on the following forms:
• Exception
• Coding
• Approval
• Invoice Search (Kofax Analytics for AP Agility)

Increase Priority lets you increase the priority of an invoice by 10 points. Use the Invoice Priority column
from the Kofax AP Agility work queue to sort and prioritize activities.

Note Increasing priority does not complete the current activity.

Email documents
The Email Document button is available on the following forms:
• Exception
• Coding
• Approval

This feature enables a user to send an invoice as a PDF to another user. The invoice assignment remains
with the user sending the document. For example, a user looking at an invoice might want to double-
check the invoice amount with the vendor.

To send an email, do the following:

1. Click Email Document.
The Email Document form appears.

2. Complete the form by entering the email addresses, a subject, and any comments.

3. Click Send Email.
The email is sent with the invoice PDF as an attachment.

Administrators specify the email address for all Kofax TotalAgility users who plan to use this option:

1. On the Kofax TotalAgility Designer Home page, click Resources.

2. Under Resources, click the Resources icon.
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3. Select the category where the required resource is included.

4. Select a group where the required resource is included and open the resource for editing.

5. Locate the Email variable.

6. Set the required value and click Save.

Routing options
The Action bar contains a menu of routing options that enable you to modify or process your document.
Selecting certain options displays a form where you can provide or correct information.

Routing option Description States where available

Approve Sends all coded and validated Non-
PO invoices without undistributed
amounts to the Approval queue after
GL Coding.

Approval

Comment request Request additional information about
the invoice from another Kofax
TotalAgility resource.

Approval, Exception, Invoice Coding

Cancel Invoice Cancels the invoice and removes it
from further processing.

Exception

Hold Places the invoice on hold from
further processing.

Approval, Exception, Invoice Coding

Reject Rejects the invoice and sends it to
Exception Handling.

Approval, Invoice Coding

Reassign Assigns the invoice to another user. Approval, Exception, Invoice Coding

Resolution Complete Indicates that all fixes were made to
the invoice that is an exception state,
and it is ready to continue through
the workflow.

Exception

Coding Complete Indicates that all changes to GL code
were made to the invoice that is in
Invoice Coding state, and it is ready
to continue through the workflow

Invoice Coding

Approval
Kofax AP Agility sends all coded and validated Non-PO invoices without undistributed amounts to the
Approval queue after GL Coding.

Kofax AP Agility assigns the activity to a user according to the following rules and order:

1. If the Auto Approval Level option is enabled for a business unit and an Invoice with the total amount
is less than or equal to the specified amount, the invoice is automatically approved.

2. If the Employee ID invoice field is set to the Kofax TotalAgility resource that is a member of the
Approvers role in the business unit, the invoice is assigned to this Kofax TotalAgility resource.
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Note If the Use Approval Chain option is enabled in the Business Unit settings, and Kofax
TotalAgility Resource is included in the Approval Hierarchy, the approval hierarchy chain starts from
this approver.

3. Kofax AP Agility defines the Use Approval Chain setting for the business unit (configured in
Configuration > Organizations > Business Unit):
• If the Use Approval Chain check box is selected: The invoice is assigned to the first approver

from the approval hierarchy defined for the business unit.
• If the Use Approval Chain check box is cleared: The invoice is assigned to the first approver from

the approval hierarchy with the limit greater than or equal to the invoice total amount.

4. If the approval hierarchy is not configured for a Business Unit, the invoice is assigned to the
Kofax TotalAgility Resource Group associated with the AP Approvers role in the role management
configuration.

The Kofax AP Agility Approval form includes the following options:
• Actions

• Submit Invoices: Before submission, Kofax AP Agility verifies that the invoice is fully distributed. If
the validation fails, the error message describing the failure reason occurs. The user needs to fully
distribute the invoice to make the submission successful.

• Discard Changes
• Save and Retain Ownership
• Increase Invoice Priority
• Modify lines
• Code invoice: Enter or select the GL code in GL Code Form. You may also use the Recent Codes

option.
• Routing Options

• Reject: When rejecting an invoice, leave a comment.
• Reassign activity to another user: Select another Kofax TotalAgility resource that is higher in the

approval hierarchy.
After reassigning the invoice, it moves to the Approval work queue for the selected resource.

• Comment Request Routing Option
• Invoice Holds

The Kofax AP Agility Approval form does not display inactive fields.

All header fields are disabled in the Approval field. You can change the line fields and add or delete lines.

Comment request
If an invoice is in the Exception, GL Coding, or Approval queue, use the Comment Request feature to
request for additional information about the invoice from another Kofax TotalAgility resource. When you
request for a comment, select a resource to assign the invoice to and add a comment with a question for
the Kofax TotalAgility resource to answer.

1. To request a comment, select Comment Request from the drop-down list of routing options.
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2. Select a resource to assign the invoice to and add a comment with a question for the Kofax
TotalAgility resource to answer.

Kofax AP Agility provides a list of Kofax TotalAgility resources the invoice may be assigned on. This list
contains all resources with the AP Contacts role in the business unit.

After the Kofax TotalAgility resource takes the Comment Request activity, Kofax AP Agility opens the
Comment Request form with the invoice image, header and line fields, and the invoice history. The Kofax
TotalAgility resource submits the invoice with the comment and the invoice is sent back to the queue
assigned to the comment requester.

Select Comment Request and enter the following in the form that appears:
• Enter comments: Add a description.
• Submit: Add a comment using the Enter Comments operation before submitting Comment Request

Activity.
See Invoice submission.

• Discard changes: See Discard Changes
• Save and retain ownership

Note the following:
• The Comment Request form does not display inactive fields.
• All header and line fields are disabled in the Comment Request field.

Cancel invoice
An invoice can be canceled only in the Exception Processing queue. When an invoice is in the GL Coding
or Approval queue, the operator can use the Reject option to route the invoice to the Exception queue
with the corresponding status. Then the Exception operator can cancel the invoice.

After the invoice is canceled, it is marked as canceled in the database.

Kofax AP Agility does not delete any information about the invoice from the Kofax AP Agility database
after it is canceled but KTA document (and hence the image will be deleted).

Invoice holds
The Kofax AP Agility Hold option is available for these three forms: Exception Form, Invoice Coding Form,
and Approval Form. The user that performs any pending activity (Exception, Coding, or Approval) can
select the Hold routing option from the list and submit the current activity. The invoice is routed to the one
of the following hold-related activities:
• Exception (Hold): AP Exception workflow
• Invoice Coding (Hold): AP Invoice Coding workflow
• Approval (Hold): AP Invoice Approval workflow

The following Kofax TotalAgility resources have access to the hold-related activities:
• The user who moves the invoice to hold-related activity
• Members of the AP Manager role specified for the invoice business unit
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The invoice is available in Work Queue and the authorized users can take a pending activity. The Release
Hold form is available for the user with a single routing option Release Hold. The user can review the
invoice header, lines and history. If the user decides to release hold, this user must complete the activity.
After the release, the invoice is routed to the initial activity (Exception, Coding, or Approval).

GL coding
Kofax AP Agility sends all imported and validated Non-PO invoices with undistributed amounts to the
Invoice Coding queue.

Kofax AP Agility assigns the activity to a user according to the following rules and order:

1. If AP Processors are associated with the vendor group or vendor naming group for that vendor, the
invoice is assigned to the specified AP Processors.

2. The invoice is assigned to the Coders role members of the business unit.

3. If the business unit does not have users with the Code invoices privilege, the invoice is assigned to
the APA Administrators group.

To perform GL Coding, use the Kofax AP Agility Invoice Coding form that includes the following
operations:
• Add and modify lines.
• Code invoices: Enter or select the GL code in the Choose GL Code form.
• Submit invoices: Before submission Kofax AP Agility verifies that the invoice is fully distributed. If

the validation fails, the error message describing the failure reason occurs. The user needs to fully
distribute the invoice to make the submission successful.

• Save and retain ownership
• Increase invoice priority.
• Discard changes.
• Reassign activity to another user: From the list the Coders role members of the business unit, select

another resource to process an invoice. After reassigning the activity, the invoice is sent to the Invoice
Coding work queue for the selected resource.
The vendor group, vendor naming group, and invalid reason routing rules are ignored for this invoice
after reassigning, until the invoice leaves the coding workflow step.

• Reject: When rejecting an invoice, leave a comment.
• Comment Request.

Open the Choose GL Code form from the Exception, Coding, or Approval forms on the Lines tab. In the
Choose GL Code form, you can specify the GL code by doing either of the following:
• In the Recent GL Codes field, select one of the ten most recently used GL codes.
• Under Specify Manually, enter or select GL account segments based on the GL segment structure

associated with the invoice organization.

Note the following:
• The Invoice Coding form does not display inactive fields.
• All header fields are disabled in the Invoice Coding form. You can change the line fields and add or

delete lines.
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Invoice escalation
The invoice escalation represents an automatic reassign to the next approver in the Approval Hierarchy
specified for the business unit. Kofax AP Agility lets users perform the invoice escalation manually from
the Invoice Search view in Kofax Analytics for AP Agility. Escalation is only available for invoices awaiting
approval.

For more information, see the Kofax Analytics for AP Agility Administrator's Guide.

Invoice submission
To complete the current workflow operation, submit the invoice. After you click Submit, Kofax AP Agility
saves all changes and the invoice keeps moving through the workflow.

By default, invoice submission completes the current Kofax TotalAgility activity. The invoice moves to the
next workflow step (such as Approve after Code) unless the operator selects to reject invoice, reassign
invoice, request a comment, or put an invoice on hold.

While you fill in the Kofax AP Agility Invoice Activity form and after you click Submit, the invoice is
validated according to the following procedures:
• Routing options
• On the fly validation
• Validation of the submitted data

On the fly validation
With Kofax AP Agility, you may take advantage of on the fly validation of input. When you fill in the Kofax
AP Agility form incorrectly, you may see a warning message indicating that you have entered wrong
values. You cannot submit the current activity if the fields are invalid.

The on the fly validation option includes the following checks:
• Input values must be of a valid type.
• Numeric fields must contain supported values. Negative numbers are only allowed in fields like Invoice

Total, Line Total, Unit Price and Quantity that support them.
• Text fields cannot contain special characters.
• Date fields must be valid.

Validation of the submitted data
After you submitted an invoice, the invoice may be validated only if the following fields are filled in:
• Invoice number
• Invoice date
• Invoice due date
• Invoice amount
• Invoice type
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Also, the data is validated according to the following checks:
• Invoice date is valid (it cannot be a future date)
• Invoice type is valid
• PO invoices: PO headers table has a record with a PO number value of the validated invoice header
• Invoice total must be equal to the total of invoice lines plus taxes and other charges
• Invoice currency exists in the Kofax AP Agility database
• Invoice does not have any possible duplicates or is not marked as a duplicate

Exception processing
If an invoice fails validation, it moves to the Exception processing queue.

Generally, the invoice is invalid for the following reasons:
• The business unit for the invoice cannot be determined.
• The vendor specified for the invoice cannot be determined.
• The invoice invalid reason field is populated after the invoice import.
• Incorrect invoice header or line values.
• The invoice is a duplicate.
• The invoice total is not equal to the lines total.

This check should be performed within the Exception activity and only if Lines were changed. For
example, Coding was performed by the Exception processor or a line was added, removed, or
modified.

• The invoice was rejected by the coder or approver.
• The invoice was routed to the Exception queue within the customization process after the invoice

import.

Kofax AP Agility assigns the activity to a user according to the following rules and order:

1. If a business unit for the invoice is unknown after the import, the invoice is assigned to the APA
Administrators group.

2. The business unit rule is configured to assign invoices with invalid reason to the specified AP
Processor (a member of the AP Processors group).

3. If the invoice has a known vendor and AP Processor associated with the vendor group or vendor
naming group for that vendor, this invoice is assigned to this AP Processor.

4. The invoice is assigned to the Kofax TotalAgility members of the Exception processors role of the
business unit.

5. If the business unit does not have users with the Process exceptions privilege, the invoice is
assigned to the APA Administrators group.

To process exceptions, use the Kofax AP Agility Exception form. The form contain the following options:
• Actions:

• Submit invoice: Before submission, Kofax AP Agility verifies that an invoice is fully distributed. If
the validation fails, the error message describing the failure reason occurs. A user needs to fully
distribute the invoice to make the submission successful.
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• Save and retain ownership.
• Discard changes.
• Increase invoice priority.
• Email document.
• Not duplicate option: If an invoice is marked as a duplicate, you can select the Not duplicate option

for the invoice.
• Routing options:

• Resolution Complete: Completes the Exception activity and releases the invoice for further
processing through the workflow

• Cancel Invoice.
• Reassign activity to another user: From the list the Exception processors role members for the

business unit, select another resource to process an invoice. After reassigning the activity, the
invoice is sent to the Exception queue for the selected resource. The vendor group, vendor naming
group, and reason code routing rules are ignored for this invoice after reassigning, until the invoice
leaves the Exception queue.

• Comment Request.
• Invoice Hold.

• Edit any header or line fields, and change the vendor or business unit for the invoice.
• Modify lines.
• Code invoices.

The Kofax AP Agility Exception form does not display inactive fields.

Approval hierarchy
Configure the Approval hierarchy as a part Business Unit Settings. APA Administrator selects the Kofax
TotalAgility resource for the Approver and Next Approver and specifies the approval limit. For the multi-
chain hierarchy implementation, specify Next Approver. Additionally, APA Administrator can specify
whether to apply the Use Approval Chain settings for a business unit or not. Depending on the Use
Approval Chain value, the approval process is as follows:
• Enabled Use Approval Chain: The invoice is assigned to the first approver in the approval hierarchy .

The first approver is selected automatically in the following order:

1. Employee Name was specified in Invoice Processing Agility (it is the Kofax TotalAgility resource )
and saved in the Invoice_Header table.

2. If Employee Name was not specified in Invoice Processing Agility, the approver with the minimal
approval limit is selected from the approval hierarchy.

After the first approver approves the invoice, the invoice moves to the next approver in the hierarchy.
The approval process is completed when the current approver has the approval limit greater than or
equal to the invoice total amount.

• Disabled Use Approval Chain: The invoice is routed to the single approver from the approval hierarchy.
The approval limit of the approver must be equal to or greater than the invoice total amount. The
selected approver can either approve the invoice or reassign it to another approver.
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Invoice duplicates processing
By default, the check for potential invoice duplicates is disabled. If required, Kofax AP Agility administrator
can enable the check for potential duplicates by doing the following:

1. On the Kofax AP Agility site, select Configuration.

2. Select General Properties >  Check Vendor Invoice for Potential duplicates.

You can check invoices by the following parameters:
• Check Vendor Invoice for Potential duplicates
• Use Invoice Date in search criteria
• Use Invoice Amount in search criteria
• Use Invoice Number in search criteria

If Kofax AP Agility determines that the imported invoice is a potential duplicate of another invoice for the
vendor, the invoice is automatically routed to the Exception Processing queue.

The Exception workflow operator cancels the invoice or marks it as not a duplicate. If the invoice is
canceled, it is routed to the Cancellation workflow. If the invoice is marked as not a duplicate, the invoice
moves further through the workflow.

Invoice validation process
Note Kofax AP Agility validation is not the same as the Kofax Invoice Processing Agility manual
validation activity. This section describes the built-in rules of validation in the Kofax AP Agility workflow.

Invoice validation in Kofax AP Agility ensures that the extracted invoice data is accurate.

The invoice validation consists of the following steps:

1. Verification that all required fields in an invoice header are valid.

2. Check for possible duplicate invoices.

The validation of the imported invoice occurs automatically. Kofax AP Agility makes a record about
validations in the Kofax AP Agility database table VALIDATION_HISTORY. The information about failed
validations is in the Kofax AP Agility database table VALIDATION_ERRORS.

The document is considered fully validated if all of the following information is correctly extracted:
• Business unit is specified
• Vendor is specified
• Invoice number is not empty
• Invoice date is not empty
• Invoice date is valid (not in the future)
• Invoice amount is not empty
• Invoice type is not empty and has a valid value
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• Document type is not empty and has a valid value
• Invalid reason code is empty
• PO headers table has a record with PO number value from validated invoice header (for PO invoices

only)
• Invoice total must be equal to the total of invoice lines

This check should be performed within the Exception activity and only if Lines were changed. For
example, Coding was performed by the exception processor or a line was added, removed, or modified.

• Invoice currency exists in the Kofax AP Agility database

Amount validation calculations
The following formulas are used to validate line items on invoices.

Line item total
Each line item in a table is valid if any of the following calculations are true.
Line Item Total = ( Quantity * Unit Price) / UofQ )

Line Item Total = ( Quantity * ( Unit Price – Discount ) ) / UofQ )

Line Item Total = ( Quantity * ( Unit Price - ( Unit Price * Discount /100 ) ) ) /
 UofQ )

Calculating due date
Kofax AP Agility calculates the invoice due date (for invoices imported not from Kofax Invoice Processing
Agility) by using payment term details of the vendor according to the following pattern:
• If the DUE_DAYS field of the PAYMENT_TERM_DETAILS table is already filled in, DUE_DATE is

calculated as follows:
DUE_DATE = INVOICE_DATE + DUE_DAYS

• If the DUE_DAYS field of PAYMENT_TERM_DETAILS is not filled in, DUE_DATE is calculated as
follows:
DUE_DATE month = INVOICE_DATE month + DUE_MONTHS_FORWARD
The day value of DUE_DATE corresponds to the value of the DUE_DAY_OF_MONTH field.

If Kofax AP Agility cannot calculate DUE_DATE, an invoice is sent to the Exception workflow.

Calculating discount due date
Kofax AP Agility calculates the invoice discount due date according to the following pattern:
• If the DISCOUNT_DUE_DAYS field of the PAYMENT_TERMS_DETAIL table is already filled in,

DISCOUNT_DAYS is calculated as follows:
DISCOUNT_DUE_DATE = INVOICE_DATE + DISCOUNT_DUE_DAYS
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• If the DISCOUNT_DUE_DAYS field of PAYMENT_TERMS_DETAIL is not filled in, DISCOUNT_DAYS is
calculated as follows:
DISCOUNT_DUE_DATE month = INVOICE_DATE month + DISCOUNT_MONTH_FORWARD
The day value of DISCOUNT_DUE_DATE corresponds to the value of the
DISCOUNT_DAY_OF_MONTH_1 field.

An invoice is not sent to the Exception workflow if Kofax AP Agility cannot calculate
DISCOUNT_DUE_DATE.

Export
Kofax AP Agility exports processed invoices and credit memos to the destination folder specified within
the ERP connection. For more information, see Integration with Enterprise Resource Planning systems .
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Common logging

Kofax AP Agility logs activity in the following locations:
• In Azure installations, activities are logged in the database.
• In other installations, activities are logged in a file.

Configure ErpConnectorService
Configure logging for ErpConnectorService, which is located in the <log4net> element. Do the following:

1. In the folder you created for the ERP Connector files, open the web.config file in a text editor.

2. Located in the <log4net> element.
<log4net>
    <appender name="FileAppender" type="log4net.Appender.FileAppender">
      <param name="File" value=" "/>
      <param name="AppendToFile" value="true"/>
      <maximumFileSize value="10MB"/>
      <layout type="log4net.Layout.PatternLayout">
        <conversionPattern value="%d %level - %message%newline"/>
      </layout>
      <filter type="log4net.Filter.LevelRangeFilter">
        <param name="LevelMin" value="ERROR"/>
        <param name="LevelMax" value="ERROR"/>
      </filter>
    </appender>
    <logger name="ERP_CONNECTOR_LOGGER">
      <appender-ref ref="FileAppender"/>
    </logger>
</log4net>

You can change the following settings:
• For File, specify the path and the name of the log file.
• For AppendToFile, set to true to add new entries to the log file.
• To include debug messages in the log for troubleshooting, for LevelMin, set the value to DEBUG.

For more information about these settings, refer to the log4net documentation on the Apache
Foundation website.

3. Save your changes and close the web.config file.
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Database logging for Azure
The database stores entries in the Log table, which has the following columns:
• Id: Automatically generated ID of message.
• Date: Date and time of the event that generated the message.
• Thread: The ID of the thread in the system.
• Level: One of four levels, Debug, Info, Warning, or Error.
• Logger: Set to "APA" to indicate AP Agility as the source of the message.
• Message: Message provided with the entry.
• Exception: Details about an exception, including the name and stack trace, if any.

To view the log from the Kofax AP Agility app in Kofax TotalAgility Workspace, select Configuration >
Log Viewer.

Note With on-premise installations, this database table and Log Messages page are empty.

Clearing the log in the database
You can clear log entries in the database by sending a job to purge entries for a specified number
of hours. Specify the number of hours in Kofax TotalAgility Designer by setting the server variable
ipaDBLogMessageRetention in the Invoice Processing Agility category. The default value is 24, which
purges entries made in the past 24 hours.

When you are ready to purge log entries, follow these steps:

1. Log on to Kofax AP Agility as an administrator.

2. Select Jobs > Create.

3. Make sure the Job option is selected.

4. In the Category field, select InvoiceProcessingAgility.

5. In the Process field, select PurgeDBLogMessages.

6. Click Create.
A message indicates that the job has been created successfully and provides a link to the job ID.

File logging for other installations
Logging is stored in the APA_<process_name>.log file where process_name is the name of the
process that generated the log (such as the Kofax TotalAgility CoreWorkerService generates the log file
APA_CoreWorker.log).

Log files are saved in the IPALogDir folder. If you want to change this folder, do the following:

1. Open Kofax TotalAgility Designer.
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2. Click Data > Server Variables.

3. In the Category Filter, select the Invoice Processing Agility category, and set the IPALogDir
server variable. Save the settings.

4. Restart the CoreWorker service on the server to apply the folder settings.

For information about this folder, see the Kofax Invoice Processing Agility Administrator's Guide.

Log level settings
You can specify the level of messages that are logged. In Kofax TotalAgility Designer, set the following
variables:
• Click Data > Server Variables. In the Category Filter, select the AP Agility category, and set the

LogLevel server variable.
• Click Form Designer > Global Variables. In the Category Filter, select the AP Agility category, and

set the LogLevel global variable.

Possible values are:
• None: Logging is turned off.
• Debug: All messages are logged (Debug, Info, Warning, and Error).
• Info: Info, Warning, and Error messages are logged.
• Warn: Warning and Error messages are logged.
• Error: Only Error messages are logged.
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Email notifications and approval

Workflow notifications
With Kofax AP Agility you can configure email notifications. Kofax AP Agility sends notifications to the
users assigned to activities if the activity is not completed within the specified number of hours and:
• Less than the specified number of days remaining until the due day
• More that the specified number of days passed since the due day
• Less than the specified number of days remaining until the discount due day

Additionally, with Kofax AP Agility you can send email notifications to the specified email addresses if
the invoice is put on hold for more than X days and Y hours, where X and Y configurable values. These
settings apply to all users.

The configuration form is available from the main navigation menu on the Kofax AP Agility site for the APA
Administrators group members. See Configure AP workflow email notification.

Kofax AP Agility uses the Kofax TotalAgility mailing feature to send emails. To send emails to the
resources and groups, you must configure email addresses Kofax TotalAgility.

If the activity is assigned to a group, all members of this group receive the email notification.

You can specify the subject and email content for each type of the notification message. Use the following
tags in the email body. These tags match the corresponding invoice fields.

Tag Invoice field and description

[InvoiceNumber] Invoice number

[InvoiceDate] Invoice date. Kofax AP Agility uses the USA date format

[VendorName] Vendor name

[Total] Invoice total amount

[DueDate] Invoice Due Date

[DiscountDueDate] Discount Due Date

[InvoiceURL] URL to the activity form that opens the invoice

The tag names must be within the square brackets in the email body.

There is an option to attach the invoice image to the email.
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Configure AP workflow email notification
1. On the Kofax TotalAgility Designer Home page, click System Settings and select Job Schedules.
2. Select the AP Agility category.
3. Click the plus sign next to Job Schedules.
4. Enter the job name, such as EmailNotifications.
5. From the AP Agility category, select AP Workflow Email Notification Process.
6. Select Active.
7. Specify the Frequency, Range of Recurrence, and Additional settings.
8. Click OK.

The job can be created automatically or manually in the Kofax AP Agility Workspace in Jobs > Create >
AP Agility > AP Workflow Email Notification.

Configure email approval
The Email approval functionality lets the Kofax AP Agility users approve or reject invoices via email
messages.

Perform the following steps to configure Email approval:

1. On the Kofax AP Agility site, click Configuration and select Organizations.

2. Select Organization and then select Business Unit.

3. Select the Email Approval check box and click Save.

When an invoice comes to the Approval activity and if it is assigned to the Kofax TotalAgility resource
responsible for the approval, the email message is sent to the address specified in the Kofax TotalAgility
resource settings. The email message contains a hyperlink to the pending activity. The approver should
use this hyperlink to log in to Kofax AP Agility and approve the invoice in the corresponding form.

Configure email body and subject
After you enable the Email Approval option on the Business Unit form, you will receive the default email
messages containing the Invoice Number and the link to the Invoice activity.

You can set up the email body and subject as follows:
1. On the Kofax TotalAgility Designer Home page, click Data and select Server Variables.
2. Select the AP Agility category.
3. Locate the Email Approval Body variable.
4. Set the required value and click Save.
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Configuration change audit

With Kofax AP Agility, you can locate and view the configuration audit details in the Kofax AP Agility
database.

Kofax AP Agility makes a record for each of the following events of the business unit configuration change
to dbo.AUDIT (AUDIT table):
• Time of configuration change
• Message that describes the change

Kofax AP Agility makes one audit record per a group of the related changes. For example, the following
events may be recorded:
• Organization was created
• General organization configuration was changed
• Field configuration was changed for organization
• Business unit was created
• General business unit configuration was changed
• Business unit role configuration was changed
• Vendor Group configuration was changed
• Vendor Naming Group configuration was changed
• Invalid reason assignment rules were changed
• ERP connection was created
• ERP connection was deleted

Kofax AP Agility does not delete this information from the data table. You can delete any information
according to your requirements.
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Workflow customization

Use the information in this chapter to customize the Kofax AP Agility document workflow. To perform the
workflow customization, use specially prepared customizable processes from the main Accounts Payables
workflow.

This chapter assumes that you are familiar with Kofax TotalAgility Designer, Kofax TotalAgility Processes
and Forms.
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Customizable workflow processes
With Kofax AP Agility, customize the following workflow processes.

Process Description Available customizable
processes

Success condition

Invoice
Validation

Extend the standard validation or
fully replace it with the prepared
processes. Use additional rules
for the invoice check. Update the
results for the standard validation.
For example, automatically mark an
invoice as not a duplicate.

• AP Before Validation
CP

• AP After Validation CP

The Is Valid process variable is
set to TRUE.

Invoice Coding Customize the invoice coding
before or after the main functional
part. You can skip a standard
invoice coding functionality and
use a custom user interface and
logic or prepare additional flows in
customizable processes.

• AP Before Coding CP
• AP After Coding CP

The Is Coding process variable
is set to TRUE.

Invoice Approval Extend the standard invoice
approval flow or fully replace it.
With customizable processes,
create additional logic and
notifications, use a custom user
interface and custom approval
hierarchy.

• AP Before Approval
CP

• AP After Approval CP

The Is Approval process
variable is set to TRUE.

Exception
Handling

With available customizable
processes, use custom exception
handling.

• AP Before Exception
CP

• AP After Exception CP

The Is Rejected process
variable is set to FALSE and
further processing is set up.

Invoice Export Use available customizable
processes before or after the
standard Kofax AP Agility export.
With Invoice Export customization,
you can create a separate export
operation to the custom destination
or provide additional handling and
notifications.

• AP Before Export CP
• AP After Export CP

The Is Exported process
variable is set to TRUE.
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Server variables customization
Enable the customization for the specified process by using the following variables.

Variable Value Description

CustomizationEnabled • True (default)
• False

Enable or disable the system-wide
customization.
To customize any server variable, set
the value to True.

UseCustomValidation • True (default)
• False

Use customization for the validation
flow.

UseCustomCoding • True (default)
• False

Use customization for the invoice
coding flow.

UseCustomApproval • True (default)
• False

Use customization for the approval
flow.

UseCustomException • True (default)
• False

Use customization for the exception
handling flow.

UseCustomExport • True (default)
• False

Use culmination for the export.

1. To customize server variables, log in to Kofax TotalAgility Designer as Kofax TotalAgility
Administrator.

2. Click Data and select Server Variables.
3. In the Category Filter field, select AP Agility.
4. From the list of server variables, select the variable to customize and open it for editing.

Customize case reference for the Kofax AP Agility workflow
Follow the steps in this section to customize the case reference for the Kofax AP Agility workflow.

1. Log in to Kofax TotalAgility Designer as Kofax TotalAgility Administrator.
2. Click Data and select Server Variables.
3. In the Category Filter field, select AP Agility.
4. Create a new variable Case Reference for AP Workflow with the following ID:

APCASEREFERENCETEMPLATE
5. In the Type field, select String and enter values according to your requirements:

• [Date]
• [Uuid]
• [InvoiceId]
• [InvoiceNumber]
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• [InvoiceDate]
• [BusinessUnitId]
• [BusinessUnitCode]
• [OrganizationId]
• [OrganizationCode]
• [VendorId]
• [VendorName]
• [VendorCode]

Place the values in the square brackets. The values are case sensitive. The maximum length of the
case reference is 40 symbols with spaces.
The case reference must be unique. Otherwise, the name is changed automatically.

Example of customization
This section provides an example of a customization process to help you understand how to apply and
extend additional options to suit your business requirements.

The following example shows how to exclude the invoice Due Date field validation during customization.
1. On the Kofax TotalAgility Designer Home page, click Process Designer.
2. On the Explorer pane, click Processes and select Process.
3. Select the AP Agility category and open the AP Custom After Invoice Validation process.
4. Delete all activities, except for the Start activity.
5. From the menu, select Variables and add the following variables:

• Cust_Error_Text: type String
• Cust_Is_Due_Date_Error: type Bool
• Cust_Loop_Index: type Long. Set the value to 1 and select Process Initialization
• Cust_Row_Found: type Bool
• Cust_Validation_Error_Set: type Dynamic Complex. Click Configure and for Column1, set the

type to String and Text as a name.
6. From the menu, select Designer.
7. Add Condition Activity (yellow square) after the Start activity and on the Properties pane, select Is

Valid in the Name field.
8. Click  to open the activity properties and click the Condition Text tab.
9. Click Variable, select Process, locate the IsValid variable, and drag and drop it to empty field to the

right.
10. Click Close.
11. Select the Is Valid activity, add the End activity (red circle) and Ordinary activity (blue rectangular)

after it.
12. Select the Is Valid activity and on the Properties tab, select True Path for the End activity.
13. Select the created Ordinary activity.
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14. On the Property tab, change the name to Get Invoice Validation Errors and the type to Data
Access.

15. In the properties of this activity, open the Configuration tab.
16. Select Server variable on the left tab, change the category to AP Agility, locate and drag and drop

the DB Connection String variable to the Connection String field.
17. Click Configure.
18. Select the Stored Procedures type and select the GetInvoiceLastValidationError procedure.
19. For the @INVOICE_ID parameter, set the value to the InvoiceID variable from Process variables

(on the left pane), and click OK.
20. For the ResultSet output parameter, select Cust_Validation_Error_Set from process variables, and

click Close.
21. Add a new Ordinary activity right after Get Invoice Validation Errors with the name Loop Error and

type Loop.
22. Open the properties of the created activity and set the value to the following process variables:

• Complex Variable: Cust_Validation_Error_Set
• Start Index: Cust_Loop_Index
• Update Index: Cust_Loop_Index
• Update Index: Cust_Loop_Index
• Row Found: Cust_Row_Found
• Number of Columns 1, Column1: Cust_Error_Text

23. After the Loop Error activity, add a new Condition Activity and set the name to Error Found.
24. On the Condition Text tab, in the properties of the Error Found activity, drag and drop the

Cust_Row_Found variable to the field.
25. Add a new Ordinary activity right after the Error Found activity and set the name to Set Valid.
26. For this activity, set the type to Expression and open properties.
27. On the Configuration tab, click the plus button after the Set Variable icon.
28. Set the target variable to IsValid and the type in the Expression field to TRUE.
29. Add a new End activity after the Set Valid activity.
30. Add a new Ordinary activity after the Error Found activity with the name Substring Error Text.
31. For the Error Found activity, on the property pane, set True Path to Substring Error Text.
32. For the Substring Error Text activity, set the type to Expression and open properties.
33. On the Configuration tab, click the plus button after the Set Variable icon.
34. Set the target variable to Cust_Is_Due_Date_Error.
35. Click Text and select Find (string, string) to add the function to the expression field.
36. Drag and drop the Cust_Error_Text variable as the first argument of the function and string "Due

Date" (with double quotes) as the second argument, click OK, and then click Close.
37. Add a new Condition Activity with the name Is Due Date Error.
38. Open the properties of this activity, add the Cust_Is_Due_Date_Error process variable to the field

on the Condition Text tab, and close properties.
39. Add a new End activity after the Is Due Date Error activity.
40. Create the link between Is Due Date Error and Loop Errors.
41. For the Is Due Date Error activity set True Path to Loop Errors.
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42. Save and release the process.

100



Chapter 11

Export to Enterprise Content Management
systems

Kofax AP Agility lets users customize the invoice workflow process to export the invoice image and
metadata to the external Enterprise Content Management system (ECM) before the export to the ERP
system.

Kofax AP Agility provides a sample integration process to demonstrate how the Kofax TotalAgility support
for Content Management Interoperability Services (CMIS) enables the integration with ECM system with
CMIS to export invoices.

If you plan to export invoice metadata to any ECM system, follow the instructions in this chapter.

Enable ECM export
Skip the steps in this section if you plan to configure and use the sample export process.

Follow the steps to enable ECM export process:
1. Log in to Kofax TotalAgility Designer as Kofax TotalAgility Administrator.
2. Click Data and select Server Variables.
3. In the Category Filter field, select AP Agility.
4. From the list of server variables, select the Enable ECM Export variable and set the value to True.

Implement export to ECM
To implement the export process with all required ECM export steps, do one of the following:

• Modify the demonstration AP ECM Export process that shows the CMIS-type integration
• Create a new process and implement the export option in the process.

If you decide to create a new process, use the Kofax TotalAgility Process Skin feature to redirect the
export execution to the new process. The process may implement any required export logic including
manual activities.
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Configure the sample export process
Use the ECM sample export process to familiarize with the features of the system. This section provides
an example of an invoice export to CMIS-enabled ECM before the export to the ERP system to help you
understand how to modify your workflow process to suit your business requirements.

This section describes how to set up SharePoint used as the CMIS repository and Kofax TotalAgility to
successfully configure the sample export process.

Create CMIS document type
To export the Kofax AP Agility document to a CMIS repository, define the target document type for the
repository.

CMIS repositories are associated with the SharePoint document library by the SharePoint CMIS service.
For the export demonstration purposes, create the invoice document type on the SharePoint server
as described later. For more information about document types, see the documentation for your ECM
system.

1. Log in to the SharePoint site where the invoices will be exported.
2. Click the gear icon to open the site settings page.
3. In Web Designer Galleries, click the Site content types link.

The link redirects you to the Site Content Types page.
4. On Site Content Types, click the Create link.

The New Site Content Type page opens.
5. Specify parameters for a new type and click OK to confirm the settings.

• Name: Specify the type name, such as Invoice
• Description: Describe the new type
• Select parent content type from: Select Document Content Types
• Parent content type: Select Document
• Put this site content type into: Set the parameter according to your requirements or leave the

default value
6. On the New Site Content Type page, locate and select the type that you have created.

The Site Content Type page opens.
7. From the new site column link, click Add to create a new field for the type. Create all necessary fields

you want to export. The demonstration process uses the fields as below:
8. On the Create Column page, specify the name and the type of the new field, such as Invoice

Number of the Single line of text type, and click OK to confirm your selection.
The demonstration process uses the following fields:
• Invoice Number: Single line of text
• Invoice Date: Date and Time
• Document Type: Single line of text
• Invoice Type: Single line of text
• Vendor Name: Single line of text
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• Company Code: Single line of text
9. Return to the Site Settings page and in Site Administration, click the Site libraries and lists link.

The Site Libraries and Lists page opens.
10. Click the Customize Documents link.

The Documents > Settings page opens.
11. In the Content Types section, on the existing site content types link, click Add.

The Add Content Types page opens.
12. From Available Site Content Types, select the document type that you have created.

You can filter the content of the list may by groups. Use the Add button to move the selected type to
the right list and click OK.

Create target export folder
Follow these steps to create a folder in the SharePoint document library:

1. Open the Site Contents page for your SharePoint site where you plan to export invoices to.
2. Select the Documents item to open the Documents list.
3. Select the Files tab and click New Folder on the tool bar.
4. Specify the folder name and click OK.

SharePoint creates a folder with the specified name.

Integration with CMIS repository
Kofax TotalAgility requires that configure the CMIS integration to use the CMIS activities. After you install
Kofax AP Agility, you already have the CMIS configuration created but you need to specify the correct
URL addresses to your CMIS services and configure the authentication settings.

1. Log in to Kofax TotalAgility Designer.
2. Follow to the Integration section and click the CMIS icon.
3. Select the AP Agility site from the list to open the CMIS Site page.

Note Kofax TotalAgility can use only SOAP binding for CMIS.

4. Specify the service URL addresses and authentication settings and click OK.

Configure temporary file folder
Kofax AP Agility saves the invoice image file on the disk before uploading it to the CMIS repository.

You must specify the path to a folder where Kofax AP Agility saves these temporary image files. The
folder must exist on the server that runs the Kofax TotalAgility core worker service. If you use a cluster
with multiple core workers, the specified folder must exist on each of them.

To specify the temporary folder path, edit the value of the Temporary File Path Kofax TotalAgility server
variable in the AP Agility category.

After the installation, the path is set to C:\Temp.
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Configure the export process
To complete the configuration of the demonstration export process, open the AP ECM Export process in
Kofax TotalAgility Designer. The process consists of the Read Fields, Export, and Save ECM ID activities.

Activity Type Description

Read Fields Data Access Reads data from the database into
the process variables.

Export Business Rules Calls the Create ECM Invoice
business rule that performs the
export. The business rule returns an
ID of the exported document to the
ECM repository.
The flow for the Create ECM Invoice
business rule includes the Save Doc
File and Add Document activities.

Save ECM ID Data Access Saves the ECM document ID in the
database. The ID can be exported to
the ERP system.

To configure the export process according to your requirements:
1. In AP ECM Export process, create necessary variables to store the invoice field data from the Kofax

AP Agility database.
You must create a separate variable for each field that you plan to export.
The variable name is unrestricted, the variable type must match the field type.

2. In the Create ECM Invoice business rule, create necessary input variables.
You must create a separate variable for each field that you plan to export.
The variable name is unrestricted, the variable type must match the field type.

3. Reconfigure the Add Document activity in the Create ECM Invoice business rule.

a. Select the repository where you plan to export the invoice.

b. Select the target type.
This is the type that you created on the CMIS server (or SharePoint in this sample.)

c. Assign the value for the ECM document fields.
Use the created business rule input variables as sources for the document values.

d. Release the business rule in Kofax TotalAgility Designer.
4. Reconfigure the Export activity of the AP ECM Export process to pass the document field variables

to the Create ECM Invoice business rule and release the process in Kofax TotalAgility Designer.

Enable ECM export
Follow the steps to enable ECM export process to complete the configuration of the sample export
process.

1. Log in to Kofax TotalAgility Designer as Kofax TotalAgility Administrator.
2. Click Data and select Server Variables.
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3. In the Category Filter field, select AP Agility.
4. From the list of server variables, select the Enable ECM Export variable and set the value to True.
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